
Read before using the software

User manual
[edition 21]

Software DDP-Ortho is intended for use only by professional users.

Software DDP-Ortho is intended for support of the orthodontic diagnostic procedure, visualization of 3D virtual occlusion models, and planning of the position and support for
the process of orthodontic brackets adhesion.

The program DDP-Ortho is used to perform three-dimensional visualization of orthodontic models. This program occurs in two versions: “Basic” and “Pro”. Both the versions
provide the user with a wide range of instruments for conducting of measurements and basic analyses on the models, while the version “Pro” allows the user also to visualize
and analyze the process of correction of position of teeth in a jaw. The measurements, known from the traditional method, are carried out in DDP-Ortho using special
instruments, featuring more precision and comfort of usage. Thanks usage of the more advanced functions of the program you can measure values that are difficult to
measure with manual measuring methods (work on sections, analysis of symmetry). The program also communicates with data base of patients, which makes it easier to
keep order in the assigning of results of analyses to particular patients.

Work on virtual models is a relatively new phenomenon in orthodontic practice. The problems of computer analyses are still in development and improvement. Therefore all
the sent to us notices and comments concerning DDP-Ortho are very valuable. Taking into consideration the long-term experience of the doctors and their needs, we will
improve our program so that its usage is as intuitive as possible and can enable the users to carry out all the most needed functions.

JST Sp. z o.o.
ul. Wały Dwernickiego 43/45
42-200 Częstochowa
POLAND

JST DT-Ortho 10.22.1EN DDP-Ortho user manual edition 21, released on 11-12-2023 for software version 2.16_2024

Read this user manual before commencing work with the software, and follow all instructions and restrictions.

Software DDP-Ortho is designed only for specialist. Specialist medical knowledge, and medical license are required to properly use the software.

Keep this user manual and refer to it in the case of any doubts.

Failure to follow this user manual may cause software malfunctioning and/or risk of generating false results, and thus may cause risk to health and life of the patients.

The manufacturer and the distributor shall held no liability for incompetent use of the software incompliant with this user manual.

This user manual describes algorithms used in the software to calculate factors and other parameters for medical diagnostics. Their use is only permitted under the condition that
the user accepts them in such a form and such a manner of functioning as created, and the user will use them being fully aware of limitations and possible substantial errors, for
which the manufacturer is not liable.

Before use of the software, it is recommended to use the technical support, including presentation and course regarding software operation.

Software DDP-Ortho uses data from 3D scanners.

Quality of the software operation (including accuracy of measurements, etc. ) depends directly of input data.

Copyright programme - version 2.16_2024



In the case of not sufficient quality of input data, the software may operate with quality that is not sufficient to use the results to support treatment procedure.

Assessment of input data quality (scans of 3D models) and results of the software operation is conducted by a physician - user of the software, who is responsible for proper
execution of medical procedure.

A physician - user makes a diagnosis assessing medical material, and prepares the treatment according to his own knowledge and experience.

In the case of any doubts related to the software, the user should immediately contact the distributor and the manufacturer and provide them with relevant information. In such
a case, use of the software results to any medical procedures is completely forbidden.

In the case of information on possible medical incident involving Software DDP-Ortho, the user is responsible to immediately inform the distributor and the software
manufacturer.

Software DDP-Ortho is not designed to operate with any defined external system (tomography, 3D scanner, 3D printer, CAD/CAM system), and in the case of such use, the user is
responsible for the manner of use of the software with the external system and for any possible necessary technical adjustment of input and output data.

In the case of any doubts, it is necessary to exclude any results of the software operation from execution of medical procedures and contact the distributor and manufacturer to
explain the situation.

Use of the software operation results as input data for external system CAD/CAM to prepare support for medical procedures has to be preceded by making sure that the software
results are medically and technically accurate, and that they may be safely used with a given external system.

Incorrect use of the software DDP-Ortho with the external system may lead to the risk for health and life of the patient.

NOTE! The software manufacturer reserves the right to modify and improve the software.
In the case the user holds any information on possible improvement to the software and provides such information to the distributor or the manufacturer, the manufacturer
agrees to consider the possibility of modifications and executes them if possible.

NOTE! Software versions intended for operation in a given year are identified as: "X.Y _ RRRR", where:
"X" and "Y" are the version number, e.g.: "1.0", and
"RRRR" is a year to which a given version is intended, e.g. "2014".
The example identification of the software as: "1.1_2014" means software version "1.1" intended for work in 2014.

The user is obliged to individually update the software for a given year and to do so, he should contact the distributor or the manufacturer of the software.

In the case there is no version of the software updated for a given year, it means the software is no longer supported by the manufacturer, which releases the author and the
distributor from any liability.

The author is not liable for medical malpractice due to use of outdated version of the software.

TThe product is intended for use in the territories of countries where the English or Polish language version of the instructions for use of such products is legally allowed.

Hardware requirements
For operating system Windows 7/8/10:

RAM: 4-8 GB

Processor i5 3.0 GHz

Hard disk 250 GB

Graphic card GeForce/ATI/Intel with minimum 2 GB RAM

For operating system Mac OSX:

RAM: 4-8 GB

Processor i5 3.0 GHz

Hard disk 250 GB

Graphic card Geforce/ATI/Intel with minimum 2 GB RAM

Mac OSX 10.6 or higher

Use of the software with a computer that does not meet hardware requirements, is technically malfunctioning or otherwise does not allow the software use according to its
designation as a medical product (software), may lead to the software malfunctioning.

The user is obliged to check technical condition of the computer hardware, and in the case of any doubts to use the assistance of professional service, including advice of the
distributor or manufacturer of the software.

Technical support, update, notices from the users
The entity responsible for distribution, update and acceptance of notices is the official distributor of the software:

ORTOLAB Sp. z o.o.
ul. Krótka 29/31,
42-200 Częstochowa
POLAND

tel. +48 343671822
e-mail: info@ortolab.com.pl

Any notices as to functioning of the software shall be submitted to the distributor by phone, letter or e-mail. Communication with use of electronic mail requires receipt
confirmation from the distributor.

Software updates are available on the distributor website.

Distribution manner: The software is only distributed in form of files to be downloaded from the website of the distributor. Distribution in form of physical carriers (CD,
DVD, Blu-Ray) is not expected. The user manual is available on the website of the distributor and may be printed if needed by the user.
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1.1. What is needed for performance of analysis of virtual models?

In order to work on virtual models one should:
- install the program DDP-Ortho;
- read the user instructions and download or order instructive films;
- send impressions to the laboratory, based on them a virtual model will be generated and sent back to the user in a form of a file ready to use in DDP-Ortho – this procedure is
effected for every impression, production of a 3D model is a fee-paid service. From the section “Files” one can download example models, which can be used for tests of work of
the program.

1.2. Program installation and startup

In order to install the program, run the file “setup.exe” and follow the instructions of the installer.
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  This is the initial screen of the installation program, click “Next”

 

then read and accept a licence agreement

 

Type in the path of the folder you wish DDP-Ortho to be installed into and click “Next”

Type in the name of Start menu folder in which you wish the DDP-Ortho shortcuts to be created and click “Next”



Choose whether the desktop shortcut for DDP-Ortho should be created or not and click “Next”

 

Check if all the options given to the installer are correct and click “Install”

 

Upon installation the program can be started from the “Start” menu or with double clicking on the icon on the desktop (if it has been created).

2. Division of screen in the DDP-Ortho program

The screen of DDP-Ortho program is divided in the following way:

 

"Menu" enables the user to gain access to all the options offered by the program.

"Tool bar" enable the user to gain quick access to some (used more often) options of the program.

"Work area" is the place where the model is shown and where most of the operations are performed.



"Panels" are for help, information and control. There are 9 panels, switched from one to another using tabs placed on the side of the panel. Panels part may be turned off by
clicking appropriate icon or from main menu: Window->Show/Hide all tabs.

The buttons in the bar can be detached to place them in a convenient place on the screen. The panels area alike. Panels can be docked to one of the 4 edges of the screen, or as
separate floating windows. To move an interface element, you must grab the dotted handler and drag it to another location:

You will find basic user interface configuration options in main menu:

Objects 3D 

The tab "Objects 3D" includes the list of all the elements (objects), of which the model is constituted (i.e. teeth and palate). Using this tab, the user can select the sub-
objects, change their names, color, visibility and transparency.

Analisys 

The tab "Analisys" includes further sub-tabs. Each of them includes result of an analysis, respectively: Popovich, Korkhaus, Bolton, symmetry, Pont, Lundstrom,Tonn,
Anterio and PAR-Index. Description of the procedure of performing of the analyses are presented in the further part of the instruction. Also from this level, widths,
heights of single teeth and of teeth segments are measured.

Each of the sub-tabs contains a brief description of the procedure.

Arches 

The "Arches" bookmark contains the options enabling the user to place the virtual orthodontic wire and position it precisely on a model. The arches are a base for
placement of the brackets, which, in turn, are bonded with teeth. All these constitute a construction enabling to correct position of those teeth which require that. From
the level of this tab, the user sets the parameters allowing simulating appearance of the dentition after the correction. This panel's options are described more
thoroughly further in the manual.



Measurements 

Here the results of the loosely accomplished measurements (measurements of: lines, angles, e.g. of the distance between the teeth, dimensions of the teeth...) are
located.

Notes

A reference system of notes corresponding with the places marked directly on the model.

Articulator

The tab "Articulator" enables the user to rotate and reposition the mandible in relation to the upper jaw. Precise description of this module is included in the further part
of the instruction.

Pictures

Here the user can take and review the pictures, both attached to the model and those taken in the DDP-Ortho program. The bookmark presents miniatures of the
pictures, which, upon clicking, can be watched in the original, increased size.

Setup

You will find there everything you need to setup brackets with arches on the model. There are tools there that enable precise assigning brackets on teeth before and
after treatment. You can also check a preview of long teeth repositioning process as a short animation.

Aligners

Section related to the preparation of aligners. After the dentition transformation preview resulting from the use of generated aligners from this place, the user can order
their physical copies.

Cephalometry

This is a place where you can make a set of measurement based on cephalogram. There are also tools to create own new cephalometry. Then if you work on multi-
model you can compare 2 cephalometries and print number results.

IPA

Options related to brackets settings on individual teeth. Available options allow you to choose the bracket type and precise positioning on the tooth. The use of brackets
is involvedly related to the use of arches on which they are embedded. For convenience, some of the same parameters are present in both the "Arches" tab and the
"IPA" tab.

Motion

Carrier Motion appliance visualization and positioning tools.

3.1. Loading model from file

In order to load a model from a file one should select the option “Open DDP-Ortho model file” in the menu “File” or click on the button

and then point the selected file in the window that will appear.
The menu “File” includes also a list of a few lately opened models.



In order to open one of the lately opened files, the user can select it from the list.

3.2. Saving model to file

A model can be saved in two ways. Pressing of the button

  

or selecting of the option “Save DDP-Ortho model file” in the menu “File” results in saving of the model (together with all the changes) into the same file from which it was loaded.
In order to save a model to a new file, the user should select the option “Save DDP-Ortho model file as” and in the window that will appear, type the name of the file in which the
model is to be saved.

 

3.3. Model information

Each model can be modified by user many times. To check actual model state user should pick "Model information" from main menu.



Model status is identified by a unique text string ( Digital Signature ). If the model was altered somehow, a new digital signature is generated and a message appears in the Model
Information window which informs about it.

In the upper part of the window, you can choose a model if the file contains several of them - the Model drop-down menu. After each saving the file the counter Number of
modifications increases by 1 and a new item with information regarding the saved file appears in the list.



3.4. Personal information

In order to complete personal information of the patient that a model is related to select File->Model information option from main menu. A new pop-up window will appear. There
you can complete all patient personal data including photo (handy for quick recognizing the case). The photo can be selected from those included in model or any outside resource
(browse the disks using Pick photo from disc function).

4. Views of model

The program can work with several modes of displaying of a model. These modes are:

Custom views

6 views

4 views

2 views

1 view

Occlusion view

 

4.1. Six views, four views and two views

All of these modes present the model in 6, 4 or 2 separate windows, respectively. In each of those windows the model can be displayed from a different angle, in a different scale
etc. Additionally size of particular windows might be easily changed by dragging lines that divide the work area.

The mode �Six views� is a default setting after each loading of a model. Double clicking on any of the six windows results with switching of the program to the mode of one view.



4.2. One view

In the mode “One view” the model is presented in one big window. This mode is the most convenient one for performing of measurements, analyses etc.

 

4.3. Custom views

Similar to the "Six views" mode, the screen is divided into 6 parts, but here the possibilities of selection of display mode in each window are extended. Click right mouse button on
one of the windows to display a selection menu. Additional options enable the user to place a picture or a note in the displayed windows. The pictures and notes available for
selection come from resources managed in tabs: "Pictures" and "Notes", respectively.

Since 1.4 version it is possible to set the way of displaying notes. Now the view which is set to displaying note may:

display the note that was manually selected - option Set note

display the recently added note - option Set newest note. Any time you add a note in notes panel this view will update automatically and will show the last added note

display the oldest added note - option Set oldest note

 

4.4. Occlusion view

   “Occlusion view” enables the user to observe the distances between points of surfaces of opposite teeth. Distances are displayed as colors. The values (in millimeters) assigned
to particular colors are described by the legend. In the window of the main occlusogram view, in its bottom part, there is displayed a simple diagram illustrating the statistics of
contacts between points of the mandible and the maxilla. The horizontal axis is the distance between two opposite points of the maxilla and the mandible. For each distance from
the range between -0.5 and 1.5 mm, the quantity of pairs of points located in this distance is marked on the vertical axis. They are points of the geometrical structure of the



virtual model and the number of these pairs of points cannot be transferred directly to the actual values. The diagram simply enables the user to estimate approximately the area
of contact of teeth in occlusion with various positions of the maxilla, related to the mandible.

 

Also, occlusion can be seen in any other view when "Show occlusion" icon is turned on ( see chapter 4.5).

In order to print an occlusion, the user should select the option “Print occlusion” in the menu “File”

4.5. Switching the views

In order to switch the mode of presentation of model, the user should select the given view from the list in the menu “View”

 

or click on one of the changing view buttons. The model might display additional information using colouring a surface as in case of showing occlusion or collision (overlapping
parts of surface are locally marked in red).

Note that 2 options are available only in View menu. These are:

Perspective view - used to switch between isometric and perspective camera angle

Stereo view - needed when using special 3d glasses

5. Manipulating the model

Manipulation of a model, it means rotating, moving and scaling can be carried out using mouse or keyboard. Manipulation with mouse is effected by “catching the model” – in
order to “catch the model” the user should set the mouse cursor in any place of the work area and press (and hold) the left mouse button – and then (without releasing of the
mouse button!) move the mouse. You can both manipulate the entire model or its particular elements (applies to "pro" models only).



5.1. Moving, rotating and scaling a view.

You can see the model is changing its position on the screen but in fact the model is "sticked" to coordinate system. In fact you manipulate the view. There are three modes of
manipulating the view: moving (translation), rotation and scaling. Changes of mode of manipulation are effected by selection of relevant option in the menu “Movement”.

 

or by clicking on one of the buttons:

 

Moving the view

In this mode catching of the view and moving the mouse (drag&drop method) results with translation of the view in the plane parallel to the monitor surface (it means “up and
down” and “to the sides”).

Scaling the model

The mode “Rotation” enables the user to rotate view around all the three axes. In this mode there are four additional corners visible on the work screen, which define a "frame
area". Catching of the view with mouse when the mouse cursor is inside this area causes the fact that after moving of the mouse, the view rotates around the axis parallel to the
screen plane. If the model is caught out of the "frame area" the model rotates around the axe perpendicular to the screen plane.

 

"Rotate view" mode is very convenient because you can perform all possible view manipulations using mouse only:

drag&drop using left mouse button - rotating of the view

drag&drop using pressed mouse scroll wheel - moving the view

rolling the mouse scroll wheel - zooming in/out the view

Scaling the view

This mode enables the user to zoom in/out the view.

5.2 Manipulating the objects 3D (elements of model)

Models may be provided as "basic" models and "pro" models. They differ inter alia that the pro model has each tooth listed as separate object on Objects 3D list. Also, each
tooth's position can be easily adjusted. Once you select any of the teeth you can precisely translate or rotate it by change of "Object rotation" and "Object translation" parameters.
If you are not happy with performed changes you can revert an initial position of the tooth by clicking "Reset transformation" button.



 

In case of working with "pro" models additional 3 icons appear on the tool bar related to transformation of single tooth.

 

Selecting one of the above icon switches to object transformation mode where all changes can be done with the mouse using additional manipulators. When mouse cursor is over
manipulator the cursor changes its shape hinting the button that should be used to use manipulator. Using drag and drop technique position or angle of the object is changing and
the amount of the offset/angle is displaying. These transformations can be also canceled by clicking on button "Reset transformation".

 

A rotation is performed around the point which is located on the screen in the begin of local coordination system. You might need to move the point so that it fits your needs. In
order to do it just click on appropriate icon and shift the center of rotation as you need. On the screen the local coordination system will be moving during that operation.

You can see below how the position of the center of local coordinate system affects on the rotation process. 



 

Individual teeth can also be combined into groups. To do this, you need to select at least 2 teeth (holding down the CTRL key). The created group is randomly assigned a different
color than the rest of the teeth. You will find the appropriate group options by right-clicking the context menu in the "Objects 3D" list.

 

Of course, the group can be ungrouped, its name and color can be changed. The appropriate options are in the context menu.

5.3. Option “Select point”

“Select point” is the fourth mode in which the mouse can work within the work area. It is automatically switched on during performance of measurements and setting of planes. In
this mode showing with a mouse button a place on the surface of a model and clicking with left mouse button causes designation of a point (measurement point or point defining a
plane). Moving the mouse while holding the left mouse button couses to model to rotate. It is also possible, while  carrying out of measurements, to switch to one of the modes of
model manipulation, to perform change of position/orientation/scale of a model and then to switch back to the mode of designation of points by selection of the option “Select
point” in the menu “Movement” or pressing of the button.

In the move/rotation/scale mode, the left mouse button enables the user to effect a model’s transformation, while the right one allows them to define/modify points, obviously
when it is possible only, e.g. while measurements are being made.



5.4. Usage of the pre-defined views

The program has available six so-called pre-defined views. They enable the user to quickly rotate a model, so that it is visible from a desired position, i.e. from the front, back, left,
right, top or bottom side. The options enabling to set a model in one of pre-defined views are included in the menu “View”. In order to reset the settings of the model to original
state, the user should use the option “Reset view”. The "Reset view" option restores the default view to all the windows – it activates
visibility of mandible and maxilla, it rotates them into the default positions, it deactivates sections, if they are active.

  

The user can also use the buttons

  

5.5. Virtual articulator

To change the position of the mandible in relation to the maxilla one should activate the “Articulator” tab. The program will show up new accessory objects - condyles. Each
condyle has own local coordinate system that determines the way of moving the mandible in articulator mode.

The elements located on this panel enable the user to:

rotate the mandible along the axis going through condyles

to rotate around the left/right condyle on the plane defined by the eminence angle of the opposite condyle

to simulate protrusion on the plane defined by the eminence angles



Each of the options above is a movement on a plane. Position of this plane is defined by 2 additional parameters - left and right condyle eminence angle. In the first case (rotation
around condyles) they are meaningless, since this is a rotational movement around the axis crossing both the condyles. With a rotation around a single condyle the mandible
movement is a rotation on a plane. The angular divergence of this plane is defined by the condyle eminence angle of the opposite condyle relating to the one around which the
rotation is made.

Protrusion is a linear movement on a plane. The plane is diverged from the level of the global coordinate system by an angle which is an arithmetic average of the left and right
condyle eminency angle.

Tip: When you change a vaule of numeric steppers you can also use "arrow Up" and "arrow Down" keys to change the value by one unit or "pageUp" and "padeDown" to
increase/decrease by 10.

The above options of mandible movements allow simulating of movements possibly most similar to those found in natural functioning of a man’s maxilla-mandible system. You can
see a preview of the movement in motion. Click on the Show animation button. A panel with parameters of the animation will pop up.

There will be animated currently selected mode of movement - one of rotation or protrusion.

"Minimum/Maximum value" determines a range of the motion.

"Interval" sets the speed of playing the animation, the lower amount of "Interval" the faster the animation will be playing. 

If "Ping-pong" checkbox is marked the animation will show the transition of the value from minimum to maximum (playing forward) and then in oposite direction (playing
backwards). When the checkbox is off playing backwards is skipped.

If "Loop" checkbox is on the animation is playing cycles one after another continuously. If the checkbox is off the animation will be played only once.

 

After each of these modifications, the user can check the teeth contact by activation of the occlusion view (the "Show occlusion" button), or switching to the occlusogram view (the
"Occlusion view" button). Changing the mandible’s position may cause mutual penetration of opposite teeth located in maxilla and mandible. Such an occurrence is signalized on
the occlusogram and the diagram by blue colour, which means that in this spot the distance between teeth’s surface is lower than zero – one teeth penetrates another.

 



It is also possible to rotate the mandible around points constituting the rotation axis, the left one and the right one, respectively. The rotation can be performed around 3 axes. The
user can establish the rotation angles for each of the axes using the Left/Right Condyle Rotation groups.

Displaying auxiliary X-ray photos

Location of condyles can be facilitated with use of an X-ray photo placed in the YZ plane. The photo should be previously calibrated (more in chapter 17.4. "Pictures"), so that the
photo scale matches the model scale. Otherwise it will not be possible to position the photo properly.

Options related to X-ray photos are placed within XRay picture and FrontXRay picture group boxes which might be collapsed (by default). Click on each of them to expand it.

In order to use an X-ray photo, the user should select it from a drop-down list in the “XRay picture” section. The list will display the photos connected with the model only. If the
photos are supplied separately, they can be added in the “Pictures” panel. Most probably the selected photo will not correspond with the model, thus its position should be
amended. The numeric fields y and z are used to move the photo in the YZ plane, while the Rotation parameter controls rotation in this plane.



Front (en face) picture can be added and positioned in the frontal plane (YZ) similarly, using the parameters from the „Front Xray picture” section.

Hint: It is best to use orthogonal views (Right/Left view, Front/view) for positioning, although in some circumstances rotation of the view can facilitate positioning of a photo. If
the auxiliary base needlessly covers a part of a photo, it can be easily hidden by clicking the appropriate icon.

 

6.1. Hiding some model elements, properties change, mesh export

Each of elements (objects 3D) of which the model is constituted can be hidden (become invisible).
The visibility of upper maxilla and mandible is controlled with the options “Show Maxilla” and “Show Mandible” in the menu “View”. In certain situations hiding the model bases
may prove convenient. The particular elements can be hidden using relevant icons:



 

During using some functions of the program (e.g. measurements of teeth for analyses) maxilla and mandible are hidden and shown automatically.

For hiding of single objects (it means particular teeth, tissue of jaw and mandible) there are checkboxes placed next to each of objects included in the Objects 3D list. The list is
divided into two areas - maxilla objects and mandible objects.

In order to make the selected object invisible, the user should uncheck (by clicking mouse button on it) the checkbox placed beside it. Putting the checkbox back will make the
sub-object visible again.

 

To change visibility of objects, the user can also use options in the reference menu developed by clicking of right mouse button on the list of objects. This menu contains also some
other useful functions, among others it enables the user to display quickly maxilla with its teeth or the mandible with its relevant group of teeth. Here the user can also change
names of particular objects and the colour of the objects displayed in the workpanel. From this level one can also export a single object (selected in the list) into a file, as a
geometric grid in the STL format. Complete maxilla can be exported with the order in the main menu: File -> Export.

Tip: Name of the object tab be quickly changed with double click on the position on the list.

 

Objects visible in the work area, that is all the ones that are marked in the list, can easily be grouped into one object using the option Create group from visible objects:



The new object gets a randomly selected color and name. Both features can of course be changed as described above. Grouping is reversible. By clicking right mouse button on a
group (in the list of objects), you can find the ungrouping function in the context menu.

When working with cases where the dentition is not complete, the user can use phantom teeth. They can be handy to design a new tooth shape. You can add a phantom tooth in
the context menu of the 3D object list (Add phantom tooth). When this option is called, the program asks for the equivalent of the tooth to be added. It will most likely be added
in an unnatural position and will require a position correction.

6.2. Changing the transparency of the objects

Sub-objects can be displayed as transparent, while the degree of transparency can be freely individually set for each object. In order to change transparency of the object, the
user should select it (click on its name on the list of sub-objects) and then change the transparency with the slider placed at the bottom of the “Objects 3D” panel.

 

 

6.3. Multi-models management



Since 1.4 version you can handle up to 10 models (model = mesh + additional data) within single session. Normally you can start working with program by opening model file (see
chapter 3). Now you can also start with empty model (no mesh, no data):

Now you need to add a model. Select "Manage models -> Open next model" option. A window with selection will pop up:

This is because model consists of : mesh and additional informations like notes or pictures or any of those. This two options work as follow:

Add only 3D model : - it adds mesh only to current created empty model. Even if model contains any additional data such as notes or pictures they will be ignored.

Merge it with empty model : - it adds mesh with all additional data.

The above selection applies to case when last model in the list doesn't contain a mesh (its also happens when starting with empty model). Whether you start with complete or
empty model using "Manage models -> Open next model" option it will result with adding another position in the model list which is seen under "Manage model" drop down panel
in main menu:

From now on you can switch between model simply by selecting one in the list. Name of the active model is displayed in the left bottom corner in each view. Having more than one
model opened has a few implications:

Most available functions will work on currently selected (active) model only.

There are new filtering options to isolate data related to active model only. For instance you can display either all notes or only added to active model.

Also when you add net note program will ask which model the note is to be attached:



Alike in case of pictures:

Notice that each picture added while being in multi-models mode has a prefix that inform what model the picture is connected to. There is also handy search field with
autocomplete facility - write part of the name to filter pictures that include entered string.

Pooled analysis can be generated. See Analisys -> Juxtaposition chapter.

A saved file will include all opened models. It becomes a multi-model file then.

You can compare cephalometries between models.

For the sake of convenience you can rename each loaded model. You will find necessary options in "Manage models->Manage models" panel:

The arrows buttons are to change models order in the list. Note that primary model has to stay first in the list and there is no way to move selected model above A one. All model
may be removed from the list (Remove selected button) except for primary model.

You can also match position of two selected models (read more in chapter 10. Comparing two models) . Go to "Manage models->Superimpose models" and select 2 models.
First - base model that keeps its position and the second that position will be aligned to first one:



Program enters into superimposition mode which you can leave using "Manage models->Cancel superimposition" at any moment. You will find detailed information about
superimposition in chapter 10. Comparing two models.

6.4 Attachments

The program allows you to place additional 3D elements (hereinafter referred to as attachments) that "stick" to the selected tooth. In practice, for example, they can be used as
control/positioning elements for aligners. To add an attachment, go to the "Setup" tab and double click on one of teeth. A selection window will open, in which you will step by step
choose the type of attachment you need. Existing ones can also be edited in other program modes by double clicking on the attachment object.

So, let's add the first attachment - go to the "Setup" tab and double-click on a tooth in the work . A window will open with a graphic selection of the attachment type:

Attachments are divided into 3 types:

hooks pressure zone additional elements

This is the most basic option. This type of
attachments is used to position aligners

during the treatment process.

This type of attachment allows you to mark
the points where the aligner will have

generated a bulge. This, in turn, will press
the tooth causing local intensification of

forces operating in the treatment process.

Additional elements support the technician
and are used, among others, to mark the

places where next rubber bands are placed.

After choosing the pictogram, the choice narrows to shape and size. By default, the attachment is placed on the outside of the dentition (the Malar option), but you can also place
it on the opposite side by selecting the Lingual option.



From now on, the selected tooth becomes the attachment carrier and by modifying the position of the tooth the attachment moves with it as if it were glued. The attachment
parameters can be modified by activating its editing window (double-clicking the mouse on the attachment symbol). However, changing its position on the tooth is possible only
when the "Setup" tab is active. To change the attachment position or angle of rotation, select it in the work area and use the manipulators that will appear after selecting it.

Przesuw attachmentu podobnie jak w przypadku zamków zachodzi przy zachowaniu kontaktu z powierzchnią zęba - attachment ślizga się po zębie przy przesuwaniu. Można ten
tryb wyłączyć zaznaczając dla attachmentu opcję Dowolne przemieszczanie. Wtedy attachment można przesuwać/obracać w przestrzeni bez ograniczeń.

The attachment movement, like in the case of brackets, occurs while maintaining contact with the tooth surface - attachment slides on the tooth when dragging. You can disable
this mode by selecting Allow free movement. Then the attachment can be moved/rotated in space without restrictions.

The display of each attachment group can be controlled separately by the appropriate icons in the "Setup" tab. Icon in the "pressed" state means disabling display of the
appropriate attachment group.

7. Planes and cross-sections

Planes are objects helping in performing measurements and sections. The program enables the user to use three kind of planes: horizontal, sagittal and frontal one. Sagittal and
frontal are perpendicular to each other and coincide with global coordinate system. The horizontal plane is allocated by any three points pointed by the user on the surface of a
model. The sagittal plane is allocated basing on a point placed by user on the surface of a model, and the longitudinal axis of the model. The frontal plane is defined basing on a
point placed by user on the surface of a model, and the transverse axis of the model. The planes: longitudinal and transversal can be also allocated in such a way that they are
perpendicular to the base of the model or to the horizontal plane.

The program enables the user to create any number of planes. Each newly created plane is displayed in the list in the Measurements panel. The currently selected plane is blue-
coloured, the others are red. Similar to other cases, the user controls the plane display with checkbox beside the plane’s name. Right mouse click in the list displays a context
menu, from which level the name of the selected plane can be changed or the plane can be deleted.



 Each plane can be used as a base to make a cross-section (read more in chapter 7.2. Cross-sections ). Selected plane might be moving along its normal (perpendicular) axis
using appropriate option from the menu. Assigning keyboard shortcuts to these options can make moving easier.

7.1. Setting planes (horizontal, sagittal, frontal)

Horizontal plane
In order to set the horizontal plane, the user should first select the option “Horizontal plane” in the menu “Planes”, or click relevant icon in the Measurements Panel:



and then point (by clicking left mouse button) subsequently three points on the surface of the model, which will belong to this plane. This process is illustrated step by step with
the images below:

Defining of the first point:

Defining of the second point:

Defining of the third point:

After the third point is defined, a plane that is allocated by the three points placed on the surface of the model, is automatically set. Position of each plane's point can be adjusted
anytime using drag&drop techinique.

 



 

Sagittal plane
Sagittal plane has an orientation as it is shown on the icon. Can be created by selecting option "Sagittal plane" from "Planes" position in the menu or by clicking relevant icon in
the "Measurements" panel.

Then the user should (by clicking right mouse button) select a point on the surface of the model and the plane will be created and added as a new position in "Measurements and
planes" list.

 

 

 

Frontal plane
Sagittal plane has an orientation as it is shown on the icon. Can be created by selecting option "Frontal plane" from "Planes" position in the menu or by clicking relevant icon in the
"Measurements" panel.

Then the user should (by clicking right mouse button) select a point on the surface of the model and the plane will be created and added as a new position in "Measurements and
planes" list.



 

 

Once plane is set you can also change its position by moving it along its normal (perpendicular) axis. You can do it in 2 ways:

by dragging a reference point of a plane:

or using options from main menu:

 

 

Perpendicular planes in the center of the coordinate system
There is a special button in the Measurements panel toolbar. It allows to set up 3 perpendicular planes located in the center of the coordinate system with one click.



7.2. Cross-sections

Each plane mentioned in the "Measurements and planes" list can be a model section plane. In order to create a section, the user should select one of the planes from the list and
then choose the menu option: Planes -> Section -> Section by current plane, or a relevant icon:

 

The selected plane produces a section crossing all the visible objects in the screen. If the section plane disturbs an analysis, it can be deactivated by un-checking in the list.

A sectioned object can be cut again with another plane.



If not the right part has been cut off, the user can switch on the part of the object that should remain after the section, using the option: Planes->Section->Inverse, or clicking the
relevant icon:

 

In order to restore the model’s condition from before the sections, the user should use the option: Planes->Section->Reset section, or select the relevant icon. Of course, it is also
possible to return to the original condition, by using for a few times the option "Undo".

8. Measurements

It is possible to effect most of the necessary measurements of a 3-dimensional object with the present version of the program. Thanks the improved integration of the auxiliary
planes and the sections with the measurement tools, the measurement process is more precise and easier to operate. However, these measurement tools require the user to
practice usage of the main functions to operate them ably. The program enables the user to measure angles, segments and distances between objects and planes. The
measurements can also be accomplished on sections.

Each accomplished measurement is automatically saved on the list of measurements and is properly named, including the measurement unit. Measurement correction can be
effected almost immediately - the quick correction system is applicable with all the measurement modes. When the mouse cursor is placed over a point included in the
measurement, the cursor mark changes into a mouse with highlited both buttons, which means that this point can be moved over the model surface when holding left or right
mouse button. Also the numbers in the measurement table are modified automatically.



Proper position of the object on the screen will obviously facilitate precise measurement. In order to make the measurement as precise as possible, the object should be magnified
and properly positioned - turned and/or translated in such a way so that the measurement performance is possibly convenient. While each screen manipulation (translation,
rotation, scaling) the program quits the measurement mode in terms of placing points which might be placed using right mouse button being in any transformation mode. Clicking
on the "Pick point" icon causes that both left and right mouse button will place new point or edit position of existing one.

All the performed measurements can be printed as a text list - with the "Print measurements" option in the "Measurements" menu. The printout includes measurements and
derivative values calculated based on them -indices, analyses - provided they have been prepared.

8.1. Measurement of a distance between two points

In order to perform a measurement of distance between two points placed on the surface of a model (or possibly on the surface of a section), the user should select the option
“Point-to-point measurement” in the menu “Measurements”, or press the appropriate button in "Measurements" panel:



 
 

Then the user should just point two points placed on the surface of the model (or section). These points will be joined with a line, and their position will be marked with two small
red planes. Result of the measurement will show up on the list in the "Measurements" panel. Remember that position of placed points can be easily adjusted using drag&drop
techniques when cursor is over the point.

Tip: It is a good idea to switch off displaying of the adjacent teeth to increase comfort and precision of a measurement (see the chapter 6.1).
 

8.2. Measurement of a distance between a point and a plane

In order to perform a measurement of distance between a point and the surface of o plane, the user should select the option “Point-to-plane measure” in the menu
“Measurements”. At least one plane has to be created before otherwise the option will be inactive.

 

Then the user should point a point placed on the surface of the model. If more than one plane is set, then the distance to the active plane is measured, it means to the one which
is displaying in the work area in blue color.



DDP-Ortho automatically gives a name to last performed measurement as "Points to plane" which can be of course changed by double click or selecting "Change name" option
from the context menu.

8.3. Measurement of an angle

In order to perform a measurement of an angle, the user should select the option “Angle measurement” in the menu “Measurements”,

 

and then point successively three points placed on the surface of the model, defining the arms of the angle, in such a sequence that the point being the vertex of the angle is
defined as second.

 

The angle measurements are automatically projected on the auxiliary grid. The number of projections of one angle equals the number of activated auxiliary grids. The figure below
depicts the situation where the angle measurement was performed with 2 auxiliary grids activated.



 

 

The measure of the angles projections is displayed in the list of measurements. In the list, below each angle measurement there are displayed the values of the projections of this
angle on the planes of the grid. In this example the angle is projected on the XY and YZ planes, since these planes are activated in the "Grid" tab ( see chapter 17.1. Grid )

8.4. Angle between two planes

If at least two planes are defined you can measure an angle between any two choosen ones. Let's say there ar two planes defined, one for maxilla and the second one for
mandible.

They are positioned relative to each other at some angle.



 

To measure this angle select position "Measurements->Plane to plane measurement" from main menu or click an appropriate icon:

 

 

A window will show up where you select two planes between which the angle is supposed to be measured. To avoid a consusion give different names to measured planes. After
selecting both planes click on "OK" button and you get a result on the measurements list.

 

8.5. Measurement with a projection onto a plane

Measurements: of distance point-to-point and of an angle can be performed with a projection onto the plane of the measurement points. The fact if the measurement points are
projected onto the plane or not, depends on state of the marker of the option “Project on plane” in the menu “Measurements”. If this option is marked, the measurements are
projected.



Projection can be active for 3 groups of measurements:

a) Project measurements on plane – these all are free measurements made in the Measurements mode.
b) Project maxilla teeth measurements on plane – these are measurements concerning maxillary teeth in the Analysis mode. They are only visible from the level of relevant
sections in the Analysis panel.
c) Project mandible teeth measurements on plane – as in the case above, but the measurements concern mandibular teeth.

Each of the measurement groups can have active projection of dimensions on one of the available planes. The user should select it by dropping down a list for the specified group.

The figures below depict the difference between the conditions with measurement projection on Saggital plane active and not active.

 

Upon activation of projection the measurement values are received from the projection plane, thus they are different from the values received when projection is deactivated.

 



8.6. Overbite

In order to measure overbite, the user should perform the following steps:

- select the option “Overbite” in the menu “Measurements” or click on the icon :

 

The view of the model will be automatically reset and the model will be positioned in the front view position.

- set a point on the surface of the model, that will be used for allocation of longitudinal section.

 

A longitudinal section will be generated automatically and the model will be positioned in the above illustrated position.

- zoom in the view so that placing new point can be more precise and then set a point on the top of one of the teeth for which the overbite is supposed to be measured



 

- set a point placed on the top of the second tooth

 

Result of the measurement will be shown on the list. The second point may be placed as many times as needed, to achieve the desired accuracy of the measurement.

Tip: After setting first point an additinal plane is created which is seen only when you rotate a view a bit. This is because the default view after switching on overbite/ovejet
measurent mode is orthogonal. If the plane might be useful for performing a measurement rotate a view after placing first point.

 

8.7. Overjet

In order to measure overjet the user should perform the following steps:

- select the option “Overjet” in the menu “Measurements” or click the icon :

 

The view of the model will be automatically reset and the model will be positioned in the front view position.

- set a point on the surface of the model, that will be used to allocation of longitudinal section.If the previously made overbite measurement is related to the currently performed
overjet measurement, try to place a point on the line of the previous measurement so that the following measurement would be performed on the same cross-section.



 

 

- zoom in the view and using overbite measurement points set another two for overjet in any order:

 

You can even overlap existing overbite's points to make sure you have marked the desired distance precisely enough.

8.8. "Macro" measurement programs

The "Macro" measurement programs are used while performing a previously established series of measurements. They make the work with a repetitive series of measurements
performed on various models faster. Let us assume that a person using the DDP-Ortho program has a task to measure the widths of all the lower left-side teeth of 20 delivered
models. In a standard situation this would mean manipulating the object to ensure a convenient position for the measurement of each tooth - let's say 7 positions of the object in
the display window - for each of the 20 models - x 20, which makes about 7 x 20 = 140 operations consisting appropriate positioning of the model in the display window
(translation, rotation and scaling) so that the model is in a convenient position for the measurement performance.

The "Macro" measurement programs can help the user here. If such a program has been defined before, then, by switching to the Measurements/Macro panel, a list of successive
items for the given measurement program should be displayed. These items are nothing else but settings of the camera "seeing" the model. It is easy to see that for oneself by
clicking one of them - the program will display the model in the window, positioned conveniently for the measurement performance.

Let us try to create a simple "Macro" program. Click on the "Measurements" tab and then click on Macro container to expand it (if it is collapsed). To create a new "Macro"
program click on the plus icon as shown on the picture below and give the name of the program.

Add the first measurement to the program. Click on the "plus" icon below a frame with names of program. A window with measurement options will pop up where you can give the
name of the measurement and select its type. The first in this example will be a distance between 2 last teeth of mandible.



Switch to the bottom view in which a mandible is visible and rescale the view so that the potentially measured dimension is displayed on the screen as big as possible.

 

The model is positioned to accomplish the first measurement of the program. Use right mouse button to set 2 points needed to measure the distance. A value of the measured
distance will show on te list. Now you need to let the program know to remember the position of the view. Click right mouse button on the first added position on the list of
measurements and select  "Update macro measurement position" option.

 

Let's make second measurement as a height of front tooth of mandible. Upon performing another measurement a new position on the list is added.

 

To remember position of the model use again the "Update macro measurement position" option. As the third measurement let's add some angle measurement. First prepare any
cross-section, set the model in right position and add another measurement as "Angle measurement".



 

Remember to save a position of the view after performing a measurement ("Update macro measurement position").

Now when you select any position from the measurements list the model will position itself to the state when it was saved using  "Update macro measurement position" option. Of
course you can adjust a view position and update it using the same option after making a correction. Also the measurement can be redone for each position - option "Do macro
measurement" from the context invoked with right mouse button. And that's the point of using macro - to perform series of measurements based on predifined view's position.

If you are happy with created macro you can export it as a file in XML format so you can reuse it with other models. So to in order to perform created macro measurement
program you need to load the model and then import the the macro program. After the program is loaded just click on each position in measurements to reposition view. For each
single measurement you can either correct it by modifying position of measurement points using drag&drop technique or redone the measurement using "Do macro measurement"
option from the context menu.

 

9. Analisys - Indices calculation

The program DDP-Ortho enables the user to calculate some useful in orthodontic practice indices: Pont, Lundstrom, Tonn, Popovich, Korkhaus, Bolton and PAR, together with
analysis of symmetry. To determine an index one should activate its tab on the “Analisys” tab and then using measurements scheme in the tab perform all the measurements
needed for calculation of the given analysis. The fields always contains only those measurements which are required for calculation of the chosen analysis. Depending on the
selected analysis the required measurements could be: mesiodistal tooth width, total mesiodistal width of a segment of teeth or a distance between teeth. Fields referring to the
mesiodistal widths of individual teeth have descriptions with numbers of teeth which they refer to. Clicking on one of the measurement fields causes a description of a
measurement to be done for this field to appear and a model to be automatically positioned in a way that is most convenient for performing the measure. Double clicking a
measurement field excludes it from the calculation. A field corresponding with an inactive tooth is red coloured. Field inactivation is used e.g. when a tooth has been physically
removed. To make it back active just make some measurement when the field is selected.

 

An exemplary contents of the measurement scheme:



Each field in area of measurements contains the mesiodistal widths of single tooth or the segment of teeth.

All the performed measurements and the indices calculated based on them can be printed as a text list with the “Print measurements” option in the “Measurements” menu. The
printout includes measurements and derivative values calculated based on them – indices.

The teeth are designated in the following way:



 

9.1. Measurement of a single tooth

Measurement of a mesiodistal width:

Calculations of each of the indices require measuring all or at least some of the mesiodistal widths of the teeth. To perform a measurement of a mesiodistal tooth width click on the
corresponding field on the measurement scheme, this will cause the model to be automatically positioned in a way that is most convenient for performing the measure.

Next, by pointing two points, the user should perform the measure of the tooth’s mesiodistal width. The measured value will appear in an appropriate field and the measurement
will be marked with two small auxiliary planes and a line connecting both measure points.



Current measurement is marked with red colour. The other measurements are marked with blue colour. At any time any measurement can be adjusted by changing the position of
the measure points. In order to change the point’s position catch it (i.e. point it with mouse, press and hold the right mouse button) and move it with mouse to the new position -
(commonly known as drag&drop technique). Of course you can manipulate the view to make the correction in most convenient way.

In many cases the user needs measurements of a tooth measured in a plane parallel to the bite plane. The DDP-Ortho program enables the user to work also in the mode of
projection of the measurements on a defined plane. In order to work in this mode, the user first should define a plane. Planes are defined separately for the maxilla and the
mandible, by choosing relevant items from the menu "Measurements" ("Maxilla plane" or "Mandible plane").

All the measured distances may be projected onto the plane which obviously must be created before. If you want to see measurements with their projection onto the plane define
the plane first and active a projection for maxilla or mandible or both depending on your needs (see chapter 8.3).

The illustration below shows the difference between the measurements accomplished in the standard mode and in the mode of measurement projection on a plane. With the
projection mode on, the measurements' results will usually have values smaller than the lengths of segments symbolizing the accomplished measurement. In this mode the
lengths of segments are only initial values for further processing of the data in analyses.

Measurement of a height:

Height measurements are performed with the same principles, by proper indication of the points defining the tooth height. The results are included in a separate measurement
scheme, which needs activation before the beginning of the height measurement.



9.2. Measurement of a mesiodistal width of a segment of teeth

In order to perform some of the analysis it is required to measure the width of a segment of teeth, that is the total mesiodistal width of several adjacent teeth. Measuring of the
segment’s width is performed in the same way as measuring of a single tooth. After clicking on the measurement field the model is automatically positioned in a convenient way,
then the user should point two measure points which define the mesiodistal width of a segment of teeth.

The measured value will appear in an appropriate field and the measurement will be marked with small auxiliary planes and a line connecting both measure points. Current
measurement is marked with red colour. The other measurements are marked with blue colour. At any time any measurement can be adjusted by changing the position of the
measure points. In order to change the point’s position use a drag&drop technique.

 

9.3. Measurement of a distance between the teeth

If the selected analysis requires measuring the distance between teeth one should click on the measure field and then point two measure points which define the required
distance.

The measured value will appear in an appropriate field and the measurement will be marked with small auxiliary planes and a line connecting both measure points. Current
measurement is marked with red colour. The other measurements are marked with blue colour. At any time any measurement can be adjusted by changing the position of the
measure points. In order to change the point’s position use a drag&drop technique.

9.4. Analysis

The calculated indices and the results are shown automatically when all the required for the given analysis measurements are done. In the following chapters the procedures the
program uses to calculate the indices are shown.

9.4.1. Bolton index

It is an analysis of the teeth’s arch length of the maxilla and the mandible. It consist in calculating the sum of mesiodistal teeth widths of the maxilla and the mandible according
to the formulas:



Entire: 

Partial: 

where:
Zij – mesiodistal width of the tooth number ij.

The way of calculating the analysis is as follows:
- determination of the mesiodistal width of the teeth 3-3 in maxilla and mandible for the partial index
- determination of the mesiodistal width of the teeth 6-6 in maxilla and mandible for the entire index

- result: comparison of the indices of maxilla and mandible represented in % to the expected values

9.4.10. Model analysis

Model analysis is a specific composition of several measurements carried out on the mandible and maxilla. The program automatically completes required fields based on
previously performed more basic analyses. Of course, each of the measurements can be adjusted based on the already known principles - After selecting one of the fields in the
measurement panel, the corresponding measurement symbol will be highlighted in the work area. You can correct the position of the points that form it by dragging these points.

Measurements of this analysis may not be carried out automatically if there are missing teeth which are necessary to carry it out.

9.4.11. Juxtaposition

DDP-Ortho enables to generate pooled analysis for easy comparison differences between models. The funcionality is called juxtaposition and you can find it at the top of
"Analysis" panel. Particular patient's file may contain 1-4 models.  Each of model (you can switch between them using Manage models->Manage models main menu option) may
include own analysis results. Usually each model stands for different stage of the treatment and doctor may want to compare numbers included with these. There is an easy way to
do that. Go to Analysis panel where you find at the very top a  Create juxtaposition button.



When you click on it a PDF file will ge created and program will ask you for selecting a place to save it. You can view the file using any PDF viewer. The file contains all the numbers
you can find in analysis panel for each available model. They are presented in rows with division for columns (as many columns as models included in the file) so that you can
compare a particuilar value for each available model. For example when you file contain 3 models loaded the raport generated will show 3 columns with values for each analysis
amount. Of course some of them may be empty if analysis was not completed.

Of course you can generate juxtaposition even if the file consists of one model only. In this case there will be simply one column in the report.

9.4.2. Korkhaus index

This index describes the relation between the anterior arch length and the sum of the mesiodistal widths of the incisors in the maxilla.

By selecting a point on the anterior dental arch the distance between the arch and the segment axis which connects 4/4 teeth is determined.

where:
Zij – mesiodistal width of the tooth number ij,



PDSZ – anterior arch length in the maxilla,
PDŻ – anterior arch length in the mandible.

The way of calculating the analysis is as follows:
- determination of the mesiodistal widths of the teeth 4-4 in the maxilla
- determination of the anterior arch length in maxilla
- determination of the anterior arch length in mandible
- result: comparison of the measured and expected values in maxilla and mandible [mm]

The auxiliary Lu value is the distance from the front of the arch to the axis connecting the 4-4 section of teeth. Appointing the points for measurement for the Lu value, the user
can mark them on any height on the tooth, since the created segment between the marked point and the axis connecting the 4-4 section of teeth is projected on the XZ plane. It
is important to mark the point possibly near the anterior part of the dental arch.

9.4.3. Lundstrom segment analysis

Comparison:
- the difference between the sum of the mesiodistal widths of the teeth in a segment and the mesiodistal width of that segment
- the difference between the sum of the mesiodistal widths of the arch teeth and the sum of the mesiodistal widths of segments

The way of calculating the analysis is as follows:
- determination of the mesiodistal widths of the teeth 6-6 in maxilla and mandible
- determination of the mesiodistal widths of each of the segments in maxilla and mandible
- result: calculated value of discrepancy for the upper and lower arch (positive or negative) represented in mm

9.4.4. Pont analysis

It is an analysis of the width of the tooth arch.

Calculation of the maxilla’s anterior width:

Calculation of the mandible’s anterior width:

Calculation of the maxilla’s posterior width:

Calculation of the mandible’s posterior width:

where:
Zij – mesiodistal width of the tooth number ij

The way of calculating the analysis is as follows:
- determination of the mesiodistal widths of the teeth 1-4 in maxilla and mandible
- determination of the anterior and posterior arch width in maxilla and mandible
- result: comparison of the expected and the measured value (the program shows the difference in mm)

 



9.4.5. Popovich index

This analysis consist in calculating the relation between the sum of the mesiodistal widths of the lower incisors and the mesiodistal width of the segment 3-5.

Calculation of the relation for the mandible and the maxilla:

where:
Zij – mesiodistal width of the tooth number ij

The way of calculating the analysis is as follows:
- determination of the mesiodistal widths of teeth 2-2 in mandible
- determination of the mesiodistal widths of segments 3-5 for maxilla and mandible
- result: comparison of the calculated (norm) value and the measured value represented in mm

 

9.4.6. Tonn index

An analysis displaying the correlation between the sum of the mesiodistal width of the upper incisors and the sum of the mesiodistal width of the lower incisors.

The sum of the mesiodistal width of the lower incisors should be equal to 74% of the mesiodistal width of the upper incisors.

Calculation of the index:

where:
Zij – mesiodistal width of the tooth number ij

If the ratio is more than 74%, it testifies excess of material of the lower incisors, compared to the upper ones. Excess of tooth material is given in millimetres and is calculated
based on the following formula:

If the ratio is less than 74%, it testifies excess of material of the upper incisors, compared to the lower ones. Excess of tooth material is given in millimetres and is calculated
based on the following formula:

 

9.4.7. Anterio analysis

This is an analysis displaying freedom of teeth in the arch. It is calculated from the difference between the mesiodistal width of a segment and the mesiodistal width of the teeth
contained in it.

In the measurements the following is taken into consideration:

The mesiodistal width of the maxilla teeth from 15 to 25 and the mandible teeth from 35 to 45.

and segments of:

Maxilla
segment 13-14-15 and segment 23-24-25

a sum of segments 11-12 and 21-22

Mandible
segment 43-44-45 and segment 33-34-35

sum of segments 31-32 and 41-42

The result of the analysis is the information whether in this case one should use widening (+)/stripping (-), which is calculated based on the formulas:

Maxilla:

Mandible:



Anterio index is calculated as follow:

9.4.8. Symmetry analysis

Apart from the above shown indices the DDP-Ortho program also enables to analyse the symmetry of the dentition. The analysis provides information on mutual location of the
teeth in relation to the symmetry axis of the maxilla or the mandible and the reference line normal to it. Symmetry analysis can be performed in two ways:
- “free” – the points needed to perform analysis are pointed manually,
- “from analysis” – the points needed to perform analysis are calculated automatically for every tooth which mesiodistal width has been already measured while performing other
analysis.

To perform symmetry analysis in "free" mode:
- activate the “Symmetry” tab on the “Analisys” panel
- by selecting the appropriate radiobutton choose which symmetry is going to be analysed: maxilla’s or mandible’s

- activating the appropriate tab choose the method of analysis: “free” or “from analysis”
- press the “New axis” button

After pressing the “New axis” button the symmetry axes must be set. To do this one should successively point three points. The first point and the second point will define the
longitudinal symmetry axis of the model and the third point will define the transversal axis (normal to the longitudinal axis).The position of each of the positioned points can be
modified any moment. The user must only place the mouse cursor on the particular point and, "catching it", move it to the new position.

While working with the symmetry axes, there are help panels (see the fig. above) displayed on the screen side. One is displayed just below the measurement table, it discusses
briefly the functions relating to symmetry measurements and a separate guide panel, which gives instructions about which actions should be performed step by step.

The position of the symmetry axes can also be copied from the auxiliary grid. Then the symmetry axes will overlap the main axes of the system of coordinates. In this case the
axes are not defined by pointing out of points - it is enough to click "Axis from grid". Copying the symmetry axes from the auxiliary grid makes sense when the model is properly
positioned in relation to this grid - this takes place when the long symmetry axis overlaps one of the axes of the system of coordinates (the bold axis in the auxiliary grid).

If there is a “free” analysis performed then the next step is to successively point in pairs points on the surface of the corresponding teeth. A pair of blue lines normal to each other
that appear for each point represent its distance from both of the axes, the values of these distances are automatically put into the table.



Pointing every successive pair of points causes a new line in the table to appear. Clicking on any of the lines causes the corresponding measure points and the accompanying lines
to appear. At any time it is possible to adjust the position of any point using drag&drop technique. The values in the table are automatically updated.

It is possible to display on the screen simultaneously all the measurements concerning symmetry. In order to perform this, the user should mark the "Show all" marker placed
above the measurement table.

 

The user can define their own colours both for the maxilla and the mandible in the options panel - the Tools/Application settings position, the "Colors" tab.

If the “from analysis” method was chosen the points on the surface of teeth would be determined automatically on the basis of the positions of the measure points defining the
mesiodistal widths of the teeth, which had been pointed previously during performing of some other analysis. E.g. if during performing the Korkhaus analysis the mesiodistal
widths of the teeth number 11, 12, 21 and 22 were measured then it is possible to automatically perform the symmetry analysis of these teeth thanks to the fact that the program
already “knows” their positions.



9.4.9. PAR-Index

The program also enables the user to calculate the PAR (Peer Assessment Rating) index. It is used in orthodontic treatment as a single-number value, which represents the extent
of the occlusion anomalies. The PAR index is a sum of a few separately calculated components, which are displayed upon clicking the PAR-Index bookmark.

Calculation of the PAR index requires determining all its components. In order to switch the program to the mode of determining of one of the components, the user must just click
this item on the components' list. The first 6 components include measurement of distance between the contact points of adjacent teeth (contacting each other if they are set
perfectly in the arch). The first component (Upper right segment) is a value dependent on the distance between the contact points of the teeth: 13-14, 14-15 and 15-16. Upon
clicking this item there will be displayed a window informing of the couples of teeth, between which the distance should be measured. Below the list there is a scheme of values of
distances reflecting the real situation. Upon clicking one of the numeric fields in the scheme, the main window will rearrange the model into the most convenient position for
performing this measurement. In order to keep the measurement precise, the model most often should be rotated to set the measurement points on its surface properly. While
determining the components of the PAR index, the main work panel is automatically switched into the mode of model rotation.

Based on the measured values the program establishes the value of the PAR index component and displays it in the list, next to the corresponding item. For small gaps this value
will have zero value. The values of the PAR index components are integer values and are displayed when some measurement threshold values are exceeded. In order to confirm
this, the user can measure one of the gaps making purposeful error enormously increasing its size - the program will automatically display next to the item an integer value
exceeding zero.

If measurements of teeth for other indices have been performed before, they can be used for the PAR index without manual measurements of the gaps' sizes. In order to use the
previous measurements of the teeth, the relevant check box in the options panel must be marked (main menu : Tools/Options).



So, the first 6 items are measurements of the gaps between specified teeth in the given segments. Another item (Right buccal occlusion) is determined by selection of one of the
pre-defined options assembled in three segments. While establishing this component of the PAR index, the model is set in a comfortable position for occlusion assessment. It is
also possible to rotate the model in the main view window then. Upon assessment of the occlusion condition the relevant options should be marked and the selection should be
confirmed with the "OK" button.

Another component is the overjet. If measurement of the overjet has not been effected before, it can be done now. In the window that is displayed while establishing this
component there is the "Make overjet" button. Upon clicking it the program is switched into the overjet measurement mode (the procedure is described in the section 10.8). If
there have been performed more than one measurement of the overjet, one of them can be selected from the drop-down list to establish the index. Next to the list there is the
"Show" button used to view the previously performed measurement of the overjet. As can be seen in the illustration below, this component consists of two segments. The first one
is derived from the overjet measurement, and the other one from selection of one of the pre-defined values. They both are summed up and presented in the list as one integer
value.

Another component is the overbite. The rules of selection are almost identical to those for overjet, with one difference: it is only possible to select one value in the window here.
Thus selection of one of the pre-defined options excludes the result derived from measurement of the overbite.

The penultimate component of the PAR index, named in the list as "Centerline" is a list of 3 positions. Based on inspection of the model the user marks the position which
corresponds best to the real situation. Upon selection, similar to the other measurements, the model is set in a position relevant for performance of the analysis, with a possibility
of rotating the model on the work panel.



The last component (Left buccal occlusion) assessment is identical as for the Right buccal occlusion.

Upon determining of all the items of the PAR index components the user receives the index value being a sum of all the particular components.

10. Comparing two models

The DDP-Ortho program enables the user to compare two models depicting e.g. the pre- and post-treatment phase.

In order to load a model (models) for comparison select "File->Open DDP-Ortho model file for comparison" from main menu or use appropriate icon.

If you want to compare the presently opened model with another one, load only one model extra. If there is not any model loaded, you will need to load two models for
comparison, one by another. After loading, the models are displayed in two different, contrasting colors, and in the list on the tab "Objects 3D" they are displayed as four objects
(because both are constituted of two elements: maxilla and mandible).

 

If you want to change a color, or name of loaded objects you fill find necessary options in the context menu ( right mouse button ).

The loaded pair of models may be shifted in relation to each other. In models comparison mode additional buttons on the tool bar are available. They are used to reposition the
selected object. The available options are:

- moving selected object ( affects selected 3D object from the list , not the entire model )
- rotating selected object ( as above ) around pivot point ( local centre of rotation )
- translating pivot point ( moving the point around which the rotation is performing )

The above object manipulating options don't affect the view, but change the location of the object in workspace. After selecting "rotate" or "translate" button an auxiliary
manipulator will show up over the selected object. When you move a mouse cursor over the manipulator, it will change its look, which means that manipulation can be started
using drag&drop technique:



 

Positioning of models in the mode of comparison is used to make observation of the differences between these models easier. For this purpose you might want to position them so
that they take the most possible coincident position to each other. DDP-Ortho is equipped with the new mechanism called Superimposition that enables the user to achieve
coincident positions after defining a series of pairs of points being related to each other. This is how it works:

Click "Superimposition view" icon or select appropriate position from the menu ( active only in model comparison mode ):

 

Program will switch to superimposition view. Then point at least three characteristic points on the model in the upper view and the same amount of corresponding point in the
lower one. You can of course set more pairs of points, which may increase the precision of operation performance.



 

You can manipulate the views while placing the points to make precise pointing of destination more convenient. The accuracy of this operation has strong influence on the final
result of repositioning. If you made a mistake while setting the points, you can easily undo each operation ( press CTRL+Z or CMD+Z(Macintosh)), modify a position of placed
points ( "drag&drop" when mouse cursor is over the point ) or delete the last set point, using the appropriate icons:

If all the points are deployed, click on the "Superimpose" button.

 

 



After short calculations are made you should see the repositioned models in the vertical window of Superimposition view. Then you can easily check the changes using
transparency slider.

11. Application settings, keyboard shortcuts

To customise a layout and way of working of the application select position Tools->Application settings from main menu. Area of settings consists of 3 tabs:

General, Colors and Path

 

Most of the available options under "General" tab are self-explanatory. Ticked checkbox makes the option active. The option "Initial sagital view rotation (in angles)" is used to set
an initial angle of left and right view. The effect of change this value is visible after clicking "Reset view" icon only.



In the "Colors" tab you can change colors of most elements of the application layout. If elements occurs as a line also its width can be adjusted. For elements displaying as a plane
besides the color its size may be modified too.

In the "Paths" tab the user can change the default path leading to the folder where the models are - the option "Always open models from the following path". During a model
loading, a file explorer will open in the folder which is just here defined.

The newer versions of the program can be downloaded from a location different from the default one - with the option "Use DDP-Ortho update address location". In the text field
the user should type the URL address of the site with the updates. This option can be used by administrators of Local Area Networks. It is not recommended for ordinary users to
change it.

12. Arches

In order to start working with the arches, click the "Arches" tab. The options necessary to position a virtual arch and
to perform simple measurements are located in this panel.

The user can choose one of the pre-defined models of arches in the "Arches" panel. As is shown in the illustration,
the panel of arches has two tabs - for maxilla and mandible. After clicking one of these tabs the "Arches" panel is
filled with data concerning the selected tab (maxilla or mandible).

The arches library alike brackets library extends over time. New sets are provided as patches for downloading.

After selecting one of the available arch models, it will appear in the main work window. If the Show arches in
global scope checkbox is selected, arches will also be visible when other tabs are active. Otherwise, arches are
visible only when the "Arches" panel is active.

Most often the added arch requires adjustment to the arch of the model's teeth. In the panel there are numeric
fields referring to: translation, rotation and scaling of the model, on two axes independently. By appropriate
manipulation with their values the user adjusts the virtual arch to the model of dentition.The colours and thickness
of the lines symbolising the arches can be modified form the menu level: Tools/Application settings - the "Colours"
tab.

 

Suggestion: the arch can be moved by the "drag and drop" method. The user should just hold the cursor pointer
for a moment over the arch symbol in the main workpanel. The "Lock manual changes" checkbox blocks this
possibility, in order to prevent accidental movement, when other instruments are used.



Since manual moving the arch may not be enough precise you can adjust its position and shape using appropriate numeric steppers .

If the the virtual arch is too long, it can be shortened at both the ends. The "Clipping" parameters (begin and end) are used for this.

 

The length of the virtual arch is instantly displayed in the panel. The user can compare the length of the virtual arch with the length of the dental arch calculated based on the
Bolton index. This is the total length of widths of all the teeth, measured separately. Marking the "Show Bolton measurements" check box will result in displaying of an arch
including summed widths of particular teeth. The borders between particular segments will be better visible upon rotating of the tooth by any angle.

The number of each segment or its dimension can be displayed next to this segment, depending on which of the clauses:

Display numbers

Display measurements

Display nothing

is selected.

The middle of the group of the measurement segments taken from the Bolton analysis is not necessarily same as the real middle of the dental arch. The position of this middle
point can be modified using the appropriate parameter in the "Arches" bookmark.



 

The particular segments (dimensions of particular teeth taken from the Bolton analysis) can be separated from each other, to make their positions in the arch similar to positions of
their corresponding teeth in the model. Upon placing the cursor over one of these segments, the cursor will change into a mouse symbol with a cross beside it. Using drag&drop
technique you can move the segment along the arch.

Red outline of the cross signalizes readiness to moving the segment whereas white outline of the cross tells about readiness to moving the entire arch.

13. Teeth segmentation

Models can be provided DDP-Ortho as :

1. a solid mesh divided only on mandible and maxilla object
2. a mesh of mandible and maxilla and set of teeth as separate objects

In case 1) you might want to isolate teeth and operate on them as on separate objects. DDP-Ortho is equiped with necessary set of functions to do it. In order to see how it works
load the file example_basic.o3m . This is a solid mesh with no isolated teeth.

Let's try to isolate a part of the model (single tooth) and convert it to separate object. Switch to the "Setup" tab. A dialog window will appear with a segmentation mode choice.
You can select manual or semi automatic segmentation.



Semi automatic segmentation is only possible to accomplish if the model is provided in compatible standard. Otherwise "Semi automatic segmentation" button will be shown as
inactive.

In manual segmentation mode you will have to isolate eash single tooth one by another. Regardless of the choosen mode the entire process is divided into a few stages (see the
figure below). The active one is highlighted in different color.

A segmentation process begins with selecting points on upper teeth. It is enough to point 4 points around selected tooth but you can set more to achieve more accurate result or
in case the surface is very irregular.
A small pop-up window will prompt of what to do in the first step. As you can see on the figure below at the begin you have to select the tooth you set the contour for. By default
18 tooth is selected but you can change it to any as an order of defining single contours doesn't matter. Also you might need to change current tooth when default 18 is not
present on the model.

Now position the view so that the tooth is going to be isolated will be enough magnified to easy define a contour (cutting line) along which separation will be accomplished. On the
left corner of the view port there is a text that prompts to start definig contour using right mouse button.

Manipulate the view so that you finish the point loop around the tooth. You can correct any point's position anytime dragging it with left or right mouse button held down. When
there is many points and you need to adjust their position "Neighbor's points to move" option come in handy. It is a kind of magnetic field. Moving one point causes dragging its
neighbors. The range of the field determines a value of "Neighbor's points to move" parameter.

If you want to deploy points for the given tooth from the beginning click the "Remove contour" button and you can start defining the contour again.



When you finish deployment of the contour points for the selected tooth go to another one. Don't click "Next" button untill all contour points for the upper teeth are set. In order to
define contour points for subsequent tooth click on the relevant position of the scheme. The field of current tooth on the scheme is highlighted in blue. Teeth for which the contour

points are set are highlighted in green.

Once you have already defined all the contours for upper teeth click "Next" button to go to the next stage.

In the second stage ("Select points on lower teeth") you proceed with very same rules for remaining lower teeth.
Once you have done, click "Next" to start generating contours - cutting line along which separation will be performed.



As was mentioned before "Select points on lower/upper teeth" stages are skipped in semi automatic mode.

Calculating separating lines might take some time. Once the process is finished you will get set of basic contours. The stage "Check contours on upper teeth" and following "Check
contours on lower teeth" allow you to adjust the shape of each contour so that it takes desired position. As you can see contour lines have more control points thus you may need

to increase the "neighbor's points to move" parameter to move more control points at once.

At this stage you can still redefine a particular contour again if you are not happy with it. First remove the contour for selected tooth, point the set of control points and click
"Create contour" button.

At any stage selected tooth is distinguished somehow both on the scheme and work area.

When you finish adjusting all the contours click "Next" button to proceed to the next step. In case of any problem with creating contour a warning will be displayed and you might
be asked for correcting some of contours. It might be handy to hide object structure and see contour lines only. To switch the display mode click the icon:



At this stage ("Check cones on upper/lower teeth") you are able to correct orientation of the symbolic tooth's root displayed in the work area as a cone. DDP-Ortho estimates the
direction along which the tooth's root is built. Some of them will look like the direction is incorrect on the first look and it should be corrected manually. See the example on the

picture below - 11 and 12 teeth need a correction:

In order to adjust the angle of choosen cone just select appropriate field on the scheme. Extra mini coordinate systems will be shown at each end of the root's axis for the selected
tooth. Now you can reposition each end by dragging any axis what effects with changing the axis orientation. After the correction the example will present like this:

At this stage you can also set the cone length. Here is how the "Cone size" parameter affects final shape:

Click "Next" to proceed the separation. It is going to take a while depending of the performance of your computer. After finishing the calculation you should get object with teeth
separated from the soft tissue. Now you can access each separated object, check "Objects 3D" tab. After separation object of soft tissue gets the pale pink color.



As you can see on the figure above isolation process leaves 2 extra objects being the part which was cutted out of the primary object. They are named as "Upper/Lower cliped
teeth". They are only used in very specific situations and you probably won't need them to be displayed. Therefore they are hidden by default.

This a moment when you accept result of segmentation process by clicking "Finish" button.

The tab changes its content. From now on it will contain the tools to preview dentition before/after treatment.

14. Brackets, appliances for the treatment of malocclusions of Class II and III

Ortolab has developed an author’s method of teeth bracketing, which compared to a traditional, purely manual process is much faster and more precise. First of all, it considerably
reduces the time of patient’s involvement in the process since most of the action is performed using a personal computer, based on a virtual model depicting dentition of a chosen
patient, and not directly on the patient. The first phase of this method requires use of the DDP-Ortho software, where the user can position brackets on a virtual model of dentition
of a chosen patient. You will find the necessary tools needed to perform this process in the "Brackets" tab.

The main element in the "Brackets" tab is a schematic arrangement of dentition. Clicking one of the elements referring to a single tooth causes appearance of a tooth in the
workpanel, unless it has been activated before. Of course, it can be deactivated by un-checking the checkbox "Use bracket". The elements referring to deactivated brackets are
marked black in the schematic dentition arrangement.



This is how work with brackets can be started. You can also activate a whole series by choosing one of the sets in the "Apply brackets for all teeth" section.

The biggest advantage of using DDP-Ortho for setting brackets is that you can set a final positions for teeth as they were after treatment and DDP-Ortho will show you the exact
position and angle on the tooth's surface where the bracket is sticked. You can manipulate with all brackets as they were mounted on the wire. In the program you actually are
moving/rotating the tooth to achieve its desired position and the application is calculating the place of the contact bracket-tooth on the fly. It is kind of reverse preceeding to
tradintional method where doctor had to imagine final position of the tooth and find the place of sticking the bracket based on his own experience.

A bracket has its basic parameters that are used in the DDP-Ortho program. The most important of them are: angulation, torque and the distance between the slot and the tooth
margin:



You can move each of the brackets on a tooth surface in the workpanel. In order to select a bracket, click it with the right mouse button. You can move a selected bracket along
one or two axes marked blue and yellow. In order to move it along a chosen axis, place the mouse cursor on this axis (the cursor’s appearance should change) and move the
bracket using the drag and drop technique. After each move (in the moment of the mouse key releasing) the bracket position in space is corrected so that the bracket would
adhere to the tooth surface as good as possible.

You can also rotate a bracket around an axis perpendicular to the red circle displayed in the workpanel. In order to perform this, similarly use the drag and drop technique, before
which operation the mouse cursor must be placed over the circle.



Positioning bracktes options described above can be achieved using numeric fields. To activate the floating panel with positioning buttons click on one of the locks on the schematic
arrangement of dentition.

Clicking on one of the available buttons will change the position / angle by the amount set in the numeric fields "Move step [mm]" i Rotate step [deg].

You can also perform precise modifications using the numeric fields in the "Brackets settings" section – the "Distance to edge" and "Ang. correction" fields.

In some circumstances you might need to move the bracket from the tooth's surface. In order to do it activate "Refine" mode (click "On refine" button). Two extra buttons will
appear with "+" and "-" label. Use them to set the distance between the bracket base and tooth surface. In "refine" mode there are also extra angle manipulators visible - blue and
yellow ring - that allow to rotate the bracket in remaining axes. The most often in order to use additional rotation rings you will have to move the bracket from the tooth's surface.



If you go to the "General settings" group in the "Brackets" panel you will find necessary options for distributing brackets on the arch(wire). You have to select and adjust the arch
shape before. Of course later modifications of the arch (after applying brackets) are still posiible. For more information about setting the arch go to "Arches" chapter. Once you
have the arch prepared you can apply the bracket set on the arch (wire). In order to do it mark the checkbox "Show brackets on wire".

Brackets along with corresponding teeth will allign their positions to selected arch. DDP-Ortho initially checks teeth arrangement against potential collision and makes distanse
between each two adjacent teeth possible equal. In practice tooth might migrate too far from their initial positions or the case requires living the gap between adjacent teeth. You
can correct their position sliding each single tooth along the arch using "Distance to previous" parameter.



As was mentioned before the easiest way to design brackets arrangement on the teeth is to turn on the wire displaying and manipulate every single bracket until entire teeth arch
takes desired shape. After repositioning you might need to check again if collision between teeth occurs. In order to do it click "Check collision between teeth" button. At any
time you can call "Arrangement of teeth on wire" routine by clicking appropriate button. Both functions are proceed when you check "Show brackets on wire" checkbox first
time.

Upon setting of a bracket you can “freeze” it using the "Accept" button. Accepting a modification deactivates the ability to select and to edit this bracket (the bracket in the
workpanel will change colour). You can cancel this operation using the "Unaccept" button.

The "Reset bracket" button re-establishes the default position of the bracket.



The highlighted fields in the above figure are used for bracket selection. The Type list enables you to choose the set to which the bracket belongs. After selecting the set a
dialogue window will be displayed, in which you can choose if change of the set should concern the currently selected bracket only, the maxilla or the mandible or the whole
dentition. You can also decide, if after change the modified bracket position should be saved or whether a new model should be positioned in the default position.

In spite of the fact that each bracket model most often is dedicated to a specified tooth, in the DDP-Ortho program you can place any bracket on any tooth. You make the choice
using the list "Bracket".

Some brackets are available in a set as various varieties, differing one from another by the Torque parameter. If such varieties are available, you can choose them using the
"Torque" list.

The Catalog no:: text field contains a full technical name of the selected bracket.

 

When working with multiple models, the position of the brackets can be copied from another model (of course if another model has already applied brackets):

It is also possible to transfer the configuration of a set of brackets in terms of their position and orientation between different files (as well as models within if the file contains
more than one). You will find appropriate options in the "Apply brackets for all teeth" group. The process comes down to saving the determined bracket positions in an XML file.
Then, using another model, you can import this file, which will move the brackets as in the original model. The structure of the model will not always allow for obtaining the same
representation of the brackets positions. In such a case, the program tries to reproduce the bracket positions as similar as possible.

In the last section - "General settings" you may decide which of the auxiliary lines should be displayed on the screen by checking appropriate checkboxes. When the option "Auto
rotate model" is active, clicking any element of the schematic arrangement of dentition (the upper part of the tab) makes the workpanel turn in such a way that the selected
bracket is located in the central part of the screen.

With the "Generate XML" button you generate a file containing detailed data concerning the used brackets and their settings. This file may be useful while placing orders,
communication with other users or with a technical assistance.

Upon defining of positions of all the brackets, the next step is generating the element being a chassis for positioned brackets.

There is also available a visual comparison that show the difference between states before and after positioning brackets. To see it go to "Setup" tab and activate the option "Show
brackets on wires". Then you can click Create layout from brackets on wire button which will generate new tooth positions based on backets. With the slider above the button,
you can see how the teeth position changes from the state before and after the brackets set has been aplied. If something does not work properly, refer the "Setup" chapter for
more information.



You can download the current set of brackets with the button  and start working again by selecting a new set.

Appliances for correcting malocclusions cases of class II and III in the sagittal plane
The O3DM is equipped with a Carriere Motion positioning tools. In combination with SL (self-ligating) brackets, it forms a unit that corrects the position of the mandible relative to
the maxilla by producing a constant slight pulling force on both arches of teeth. Depending on the class of defects, the Motion is fixed to 3rd (canine) and 6th (first molar) tooth of
mandible (Class III) or maxilla (Class II) while the bracket on the opposite side to the last molar. The bracket and the device are connected with an elastic rubber band. For the
rubber attaching points are: the bracket with a hook and a hook placed on the Motion's foot which is fixed to the canine.

To enable the Carriere Motion display go to the Motion tab and in the first step select one of the available libraries:

The program, for a few seconds, calculates the position for the appliance and displays it in the work windows.

This is the position suggested by the program calculated on the basis of fairly complex algorithms. However, you can correct it. In order to do this, click on the Carriere Motion ball
joint. You will see the manipulators enabling you to perform position correction:



Lines marked with black arrows are used to move the base of the appliance on the tooth surface. After each such a correction, the position of the appliance is recalculated. The two
circles marked with the white arrows in the picture above are used to the rotation of the appliance, nevertheless the rotation with a large turquoise circle causes the arm to be
rotated in the range limited by the ball joint. If the rotation range is greater than the allowable connection (the arm rests on the spherical case of the arm foot), then the foot with
the ball connection is also rotating (the whole set rotates).

You can also make corrections using the appropriate "Distance to edge" and "Angle Correction" numeric fields. This part works very much like brackets tools. Similarly, you
can also lock the position of the appliance with the "Accept" button - the appliance in the window area will turn green and changing its position become impossible until it is
"Unaccepted".

It may be that the appliance used is too small and does not fit properly in spite of the adjustment. Then change its size:



15. Setup

In DDP-Ortho you can both setup brackets or teeth depending on the goal you want to achieve. The chapter "Brackets" is devoted to explanation of the process of positioning
brackets on teeth. Here you will find out how to position teeth. All the information presented here apply to model with isolated teeth only.

If you go to "Setup" tab there are several options and icons at the very top. Let's have a quick review over them.

Show brackets - this is a switch to turn ON/OFF displaying brackets.

Show arches - this is a switch to turn ON/OFF displaying the arch which is selected and customised within "Arches" tab. Notice that only the symbolic curve for the arch is
displayed and displaying the arch doesn't affect bracktes position.

Show brackets on wires - the effect of using this icon is as same as checking the option "Show brackets on wire" in "IPA" tab except that it concerns both wires - upper and lower.
When you turn it on the brackets displayed will be alligned to the wire. Also the wire (defined in "Arches" tab) is going to be displayed in its real shape.

At this stage it is worth to explain the meaning of other options in the tab. Below the row with the icon button are two lists. Each position in the list is some state of teeth
arrangement relative to the gum. Below the list, in the "Setup" panel there is a slider. You can preview the transformation (from the initial position to the end positions) of the
items whose positions were modified. You will notice that the slider is sometimes active, sometimes not depending on the status of the icon buttons and the selected items in the
"Layout 1" / "Layout 2" lists.

Layout lists contain at least two items:

Initial position

Manual setup

"Initial position" determines the state of the patient's dentition taken from the scanning device. Whereas, the "Manual setup" is the state of the possible modifications of the
position of the teeth in the program. It is often the case that the two positions do not differ from each other unless the position of the individual teeth is manually adjusted. Then
the slider movement does not cause any change on the screen.

There are 2 ways to get a new layout - by positioning the teeth or applying ("IPA" tab) the brackets. Let's clarify the first one - positioning the teeth. Transformation of teeth
arrangement with a slider between two states, whose the difference is due to the modification of the tooth position (and not the setting of the brackets) is only possible if the
"Show brackets on wire" icon button is inactive.

Let's take a look at options of manual teeth positioning. When the "Simulate Soft Tissue Movement" checkbox is active, the estimated gingival deformation will also be visible
when changing the tooth position. The current collision analysis mode is also useful.

After its activation, the tooth position change is checked for possible collision with another tooth, which in this case is highlighted in red. The greater the overlap value of one tooth
in the other, the more red approaches black. When the move is completed (the mouse button is released) the value of the overlap is displayed in millimeters (so-called stripping).

In addition to the stripping value, some teeth may have symbols that indicate critical shifts/rotations during the treatment process. Yellow symbolizes a warning for a large
displacement value, while red indicates an impossible value.



The collision is checked within the row of teeth - upper or lower. In a situation where a tooth collides with 3 three teeth - two adjacent ones and one lower one - the stripping value
will be shown only for 2 neighboring ones. The figure below illustrates this situation. In this case, the collision with the lower tooth is only signaled in red (if the collision check
mode is enabled):

You can display the stripping value for all existing collisions on the screen. The following conditions must be met:

view in Top/Bottom mode

Show stripping for all teeth checkbox active

the transformation preview slider should be in the final position

If the above conditions are met, you can view the complete displacement distribution for the mandible/maxilla:



Returning to the symbols warning about excessive displacement - their appearance and the appropriate color depend on whether certain threshold values are exceeded for various
types of displacement/groups of teeth. You can set these values yourself by selecting "Tools -> Application settings -> Movement threshold" in the main menu. The list has limits
for shifts and rotations, use the scrollbar to reach all:

You can change the threshold values with no worries, you can restore the factory settings at any time with the Reset to defaults button.

During the displacement, their parameters are displayed in real time in the upper left corner of the work area. When any of the threshold values is exceeded, its color changes
accordingly:

to yellow - when the "warning" threshold is exceeded

to red - when the "critical" threshold value is exceeded



The tooth is selected with the right mouse button. (When you can see brackets on the screen, you can not choose the tooth, then choose by clicking on a bracket.) After selecting
the tooth you can:

move it by dragging one of the axis of local coordinate system displayed on the selected tooth. You can also click on selected tooth while holding down CTRL (CMD
Macintosh) key and then, by moving the mouse, move the tooth in the plane of the screen (the green cross symbolizes the move in the plane of the screen)

rotate it around one of 3 axis - click the icon "Rotate object" to activate the mode first. You can also click on selected tooth while holding down SHIFT key to rotate in the
plane of the screen or holding down CTRL (CMD Macintosh) and SHIFT to rotate around tooth's long axis.



Once you've made the modifications, you can preview the transformation from the initial position to the final position using the slider. Be sure to select in the "Layout 1" list the
situation before changing the position of the tooth and in the "Layout 2" after modification.

The program also automatically calculates new teeth positions of the entire dentition based on the selected arch and the position of the brackets. These functions are activated
with buttons located just below the slider:

Create layout from the arch

Create layout from brackets on wire

Let's take a closer look at these buttons.The "Create layout from the arch" button is active if you enabled Show 3D arch checkbox. You can modify the shape of the 3D arc by
moving its control points:

Its use causes the teeth arrangement so that the bite curve is best suited to the shape of the arch. A new position will be added to both lists:

It is often possible that after using this function the teeth will be in an unnatural position. You can then adjust both the position (by drag and drop) of the arc and its shape (you
have to switch to the "Arches" tab). After correcting the arch, you will need to generate new teeth positions again using the Create layout from the arch button. Every time you
use it, you will see a new item in the layout lists. You can change its position in the list relative to other items, you can change its name. You can also delete failed attempts to
generate new layouts. The appropriate options can be found in the context menu (right-click on the list item).

Each use of the button will create an item in the list with the same name by default, so if you want to keep your order, you may want to change it, for example, by adding a short
annotation in the name after the curve correction.



As you noticed new items always appear on both lists. This allows you to preview transition between two arbitrary layouts. To try the transition preview, select 2 different items in
the "Layout 1"/"Layout 2" lists and move the slider to observe the changes on the screen:

The trajectories of each tooth transition are linear by default. The program can also calculate the transition trajectory based on screw movement, which in certain circumstances
turns out to be the most optimal. The tooth transition based on helical movement can be enabled by selecting the "Screw movement" option. An additional axis is then displayed
for the selected tooth, which is the axis of the cylinder constituting the basis of the helical trajectory. At small displacements, the differences between linear and helical transitions
are visually difficult to detect.

The algorithm of tooth arrangement is based on the shape of an arch, Bolton's analysis and the orientation of the long axis of each tooth. The long axis may not always be properly
located, which can cause situations as in the figure below:



The long axis of the tooth can be easily corrected. To activate additional manipulators, right click on the tooth while holding the SHIFT key. Correct the position of the long axis by
moving its control points and recalculate the teeth arrangement one more time (button Create layout from the arch):

Create layout from brackets on wire button will only work if brackets have been applied before. After positioning the bracket correctly (see chapter "Brackets"), activate the
"Show brackets on wires" icon and generate a layout based on brackets. After the layout is generated, a new item is added to the list:



Right below the slider there is a short statistic information that says what is maximum deviation at final position. Let's discuss the example numbers show on the figure below:

Each single tooth has been checked for minimum offset maximum offset and rotation and the highest values are put into second column. Refering to the figure above the value of
1,46 means that the tooth which made the smallest dislocation has moved by 1,46mm. Similarly the highest detected offset equals to 7,46mm. However above parameters for the
selected tooth are takes accordingly value of 2,27mm/2,85mm. The most rotated tooth has been turned by angle of 14,13 degrees and selected one by 8,17 degrees.

Hide the gums - it is a switch to display the soft tissue that is the gum.

Show only selected tooth - by using this icon you can temporarily isolate selected tooth in the work area hidding all remaining objects. The icon is active only when tooth is
selected. It becomes inactive while selecting bracket.

Automatically update occlusion - it applies when "Show occlusion" mode is on only. After any change made on particular tooth its contact distance color map is updated.



16. Cephalometry

If you go to "Cephalometry" tab you will find necessary tools to accomplish cephalometry analysis. Caphalometry is based on the X-ray picture on which series of measurements is
performed. Measurement sets vary depending on the purpose they are used. You can import cephalometry into DDP-Ortho as it is stored as XML file. If you don't have one you
can create new own cephalometry which will be stored in DDP-Ortho. Created cephalometry can be also exported to XML file. Thank of that user can swap cephalometries with
other DDP-Ortho users.

All necessary option for importing/exporting cephalometries can be found in File menu:

Well, let's go back to the case there is no cephalometry available and new one is to be created.

Creating new cephalometry analysis
Click the "plus" icon to open cephalometry creation wizard.

You will be prompted for the analysis name. For the purpose of following explanation generic names will be given.



Click "next" button to go to the next step where you define points. You will use points marking specific places on cephalogram (the x-ray picture which is a base of cephalometry
measurements). Also points are necessary components to define lines - another item used in cephalometry. Each newly created point should have given a name and symbol which
is an abbreviation used later on diagrams. You can also change a default color.

The "Description" field is optional and contains text displayed when mouse cursor is over specific position in the list while performing cephalometry:

After the point is created it goes into the list. If you click on any item from this list you will see two extra buttons:

Save point as new - it creates a copy of selected point (saves time when only small changes are to be done in names)

Save point - overwrite existing point data if any changed

After adding the required number of points (you can add more points later by editing existing analysis), go to the next step - create a line. Additional checkboxes under the color
picker make it easy to create a point for specific geometric conditions. However, some of them require lines to be created, so they will be discussed below. By clicking on the
"Next" button you will be taken to the step of adding a line.



From the two drop-down lists under color picker select 2 different points forming the line. All remaining options works the same way as in case of defining a point. Based on the
two selected points the program can create:

a segment

a half-line

a line

depending on selected checkboxes:

If you need to create a perpendicular line passing through one of the points forming the line, select the appropriate checkbox:

If you have already defined any lines, you can go back to adding points (click "Back" button) and create points using additional options. Normally, you need to select reference
elements as additional points or lines. For example, if you create a point that is a projection onto a line, you must also select the projected point and the line to which this point is
projected:



Here are the diagrams for the other options for creating a point:

Mid point - creates a point between 2 selected points at equal distance from them

Cross line - Creates a point at the intersection of selected lines

Rotate point - Creates a point formed by the rotation of a selected point around the second trading center



After adding points and lines you are ready to define particular measurements. Click "next" button to see the window as below. Note the marker for the direction of an angle
calculation seen when selecting certain functions. It affects the angle sign in the results table.

This is a window that contains needed options to arrange the report layout that is an output of analysis made. The first drop-down menu contains possible functions - types of
measurement and one special function - header. The header is to seperate groups of taken measurements in the cephalometry results printout. After selecting a function
corresponding fields appear.

Two special parameter may need additional explanation:

standard value - expected value based on medical practice

standard deviation - the value that the measured amount may vary from standard value. When the measured value exceeds the standard value by more than standard
deviation the result is marked with an asterisk in the results printout. When it exceeds more than twice - with 2 asterisks, and 3 of them when the measured value exceeds
standard value by more than 3 times standard deviation (check the sample results printout the section below - Performing cephalometry analysis).

The example list of measurement functions for cephalometry:

The last step is to set defined points on the schematic picture. The points distribution will be used later while making cephalometry analysis. All you need to do is select point by
point and place them on the diagram at relevant positions by clicking right mouse button.



You can correct existing cephalometry scheme. Then showing all set points may be handy.

If you are sure all the points are placed in correct positions you can finish creating of cephalometry scheme by clicking "finish" button. All existing schemes might be
edited/corrected later using the same "Cephalometry wizard" (use the "edit" icon next to "plus" icon in the panel).

Performing cephalometry analysis
At first step select one of available analysis and click "Start" button.

If there is no cephalogram (picture dedicated as a base of cephalometry analysis) you will be asked to select one from "Pictures" library. Selected picture must be calibrated (see
"Pictures" chapter). Once the picture is ready you can start pointing series of points on the cephalogram in accordance with the help picture containing a set of reference points.
Select point by point on the list and place it on the diagram using right mouse button.



If you have a problem with recognizing some areas you can adjust displaying a cephalogram using options from "Adjustments" group in the panel. All the points included in the
scheme have to be placed on the diagram, otherwise you would not be able to generate the report. Point that are already done are marked in green and currently selected point is
marked in red.

When all the points are arranged click "Results" button to generate an XML file which contains results of the analysis. If generating results table succeed you will be asked if you
want to add results table as a picture to library ("Pictures" tab).

This is what the results table may look like:



By moving any of the reference points, the measurement results associated with this point are updated in the table on the fly:



The table of results can also be printed. With the option of printing, a .PDF file is generated, which contains a table of results and measurements plotted on the cephalometric
image. After clicking the "Print" button, the program will ask for a location to save this file, then ask if it should be displayed on the screen using a system PDF viewer.

Soft tissue

When you have cephalometry done you can mark a soft tissue by drawing green contour in the cephalogram. It may be used for later cephalometries comparison or other analysis.
In order to star drawing the soft tissue enter the drawing soft tissue mode by clicking appropriate icon and set subsequent point in the cephalogram by clicking right mouse button.



At any time you can modify the position o particular point by dragging it with left mouse button or even position of entire contour by dragging any of segments that form the
contour.

Cephalometries comparison
When working with multi-model (see chapter 6.3. Multi-models management) you can attach separate cephalometry to particular model. So for each loaded model you can
have separate cephalometry results along with soft tissue contour.

Let's say you work on multi-model file that contains of 2 models and each of them have cephalometry measurements done and soft tissue shape defined.

You can compare them by overlaying. Go to Compare cephalometries tab and select 2 cephalometries you wish to compare. After selecting they will be highlighted in their lists:



From now on, you can compare desired elements turning them on/off in the toolbar:

If you need you can also turn on displaying points of cephalometry. The is also possibility of generating table with results of each cephalometry used in comparison (there will be 2
tables in generated picture).

As you can see on the side by side comparison above contours seems to be spaced apart too much. This is because cephalograms vary - they are very likely rotated or moved in
relation to each other. In order to match their position click Compare button and select two the same points for both compared cephalometries. These 2 points should not be close
to each other. The more distanced are they the better match can be calculated.

After selecting reference points compared contours should match better in terms of their position:



Surgery
There is an assistance panel for surgeons with simple tools. You can there correct soft tissue contour shape and add a line which acts as direction guide. Add one or more lines
after clicking on Add help line icon and mark Move along line option. Then you can select the line along the movement will be performed with.

17. Working with models online. Aligners

The user registered on the ortolab.com.pl website has the ability to manage models sent to the laboratory and monitor the processing status of a given model. You can access the
same resources from the DDP-Ortho program. You will display the login window by selecting Account option from the main menu:



Access to remote resources is possible only when the server is ready for operation, which is signaled by the green control. After logging in, you gain access to both digital models
sent via the website and aligners. The part related to aligners is available only from the DDP-Ortho program. The table contains a list of all models related to the user's account
along with the basic data. Each of these models can be downloaded to local disk. To do this, select an item from the list and click "Download" or simply double click on the item
from the list. The model will be downloaded from the server and saved to disk in the indicated place and automatically loaded into the program. In summary, the "3D models"
section is a browser type of user resources located on a remote server.

The "Aligners" section is used to control the order flow of aligners that implement tooth displacements designed by the doctor ("Set-up" tab) to cure dental defects. On the basis of
the file prepared by the user, Ortolab technicians prepare a series of necessary aligners for treatment and send it to the user by courier. The number of delivered aligners depends
on the biomechanical limitations that are associated with the permissible rate of deformation of soft tissue / bone in the treatment process.

The procedure should be correctly started from entering the patient's personal data: File->Personal information. In the absence of completed personal data, the program will ask
for them when sending a model file with a set-up.

One of the next key steps is to design teeth displacements ("Set-up"). Once the set-up is completed, the doctor (user) can start the aligner ordering procedure by sending the set-
up to the server. The tab has the appropriate button:

From now on the "Aligners" list in the "User Account" window a new item appears with the status "Waiting for examination":



This means that the Ortolab laboratory received information about the submitted file. At the moment when the verification procedure starts, the file status will change to "Under
examination" and from that moment the possibility of sending the file is blocked. At any time you can download it ("Download" button):

After successful verification, Ortolab prepares a series of aligners and appends the displacement simulation for each aligner to the file. The prepared file is waiting on the server to
download by the user. The status changes to "Awaiting your verification":

After downloading the file, a new icon opening panel dedicated to the preview of generated aligners will appear in the icon column:



The entire transformation associated with the operation of aligners can be quickly seen by moving the slider marked in the above figure with the letter F. If you want to see the
changes occurring only for the maxilla or mandible, use the sliders marked with C and D. By clicking on the respective fields in lists A and B you will display the target position of
the selected aligner in the work area.

The treatment process can occur simultaneously for the maxilla and mandible. The number of stages of transformation, and thus the number of aligners used, may vary for the
maxilla and the mandible. In the figure above we have a situation in which the treatment in the maxilla area takes place in 6 steps, while in the mandible region in 8. Individual
steps for the maxilla and mandible are marked in the picture in panel E. It can be seen that when the treatment in the maxilla area ends, the mandible area will still last for 2
steps. The column labeled E1 contains clickable numbers representing the treatment step in the work area. After clicking, the teeth takes in the work window the position
corresponding to the presence of the corresponding aligner. The stripping values are also displayed for all teeth involved in possible collisions.

Stripping values are displayed only when the view is in Top or Bottom mode. The blue field displays the stripping value for the current step and the red field displays the
maximum value found among all the steps for the tooth.

Displacements and stripping values can also be seen for the selected tooth. It may happen that the aligner does not affect the tooth at any stage of the total treatment. Then only
the steps in which the selected tooth is displaced will be marked in the table. Here is the situation when, during 14 stages of treatment, tooth 37 moves only in stages 3-5 and 8-
9:

If you decide that the aligners behave according to your expectations, you can place an order by clicking the "Accept" button. If not, you can correct the set-up and send it again,
starting the verification procedure again.

After clicking "Accept" a message will be displayed reminding you that it is an order, so the action related to the fee.

The status in the "Aligners" section will change to "Ordered":

At this stage, you can no longer correct this model (you can still download it - the "Download" button). The order is completed and the user expects a courier parcel with
aligners.



18. Extras

The program has also a few extra options related to displaying additional elements, that can facilitate accomplishment of measurements. There has also been added a system of
reference notes facilitating accomplishment of quick description of specific parts of a model, placed directly on it, which is very helpful in putting work with model into order. These
and other extra options are described in this chapter.

 

18.1. Grid

The user can work with accessory grid switched on or off in the display window. The grid is a system of adjacent squares with 10 millimeter-long sides. Working with the grid
enables the user to estimate approximately the size of the object or of the planned measurement. The accessory grid is activated by the user by clicking relevant icon in the "View"
menu or with keyboard shortcut (default shortcut is CTRL+Alt+G or CMD+ALT+G (Macintosh)).

 

DDP-Ortho can display up to 3 grids which overlap global coordinate system by default. User can decide which of them should be turned on and correct their location and rotation
if needed.

Both model and grid can be displayed using orthogonal view or perspective view. You can easy find the difference especially when the grid is on by switching both modes using
appropriate menu options:

 

18.2. Guides

As a response for the current program users' needs a possibility of defining guides has been introduced. The guides are accessory lines created by clicking two points on the model
that define a straight line - guide. The guides do not have a strictly defined use, their usage is up to the user's needs and imagination only. They can be, for instance, a temporary
frame of reference for performance of a series of measurements.



The options of guides are available in the "Measurements" panel (the tab
"Guides"). The guides are added the "plus" button. The user can give their
own name of a guide by right-clicking the relevant element of the guide list.
Projections of the angle between the guide and the plane appear below the
guide name. Their quantity depends on active grids (the "Grid" tab), like in
the angle measurement.

The quantity of defined guides is not limited. However, one should remember
that a defined point is placed on the model surface. In the mode of defining of
successive guides, similarly as in most functions of the program, the function
of a quick correction is active. When the mouse cursor is placed in proximity
to one of the points defining a guide, it changes to a symbol of a hand. This

means that the user can move this point on the model surface, thus accomplishing a quick correction of its location.

In the illustration below the arrows mark the points that have previously been clicked to create the displayed guide. The user can move a
point keeping the right ( or left after "Pick point" icon is clicked ) mouse button pressed and sliding the point on the model surface. The
position of the guides is corrected instantly.

 

 

The guides work as magnets for the placed measurement points. It means that measurements can be performed on the guides by placing on them the measurement points while
performing the measurement, and by moving previously placed measurement points onto the guides. Placing a point on a guide is announced with change of the cursor colour. The
best way to ensure that the required measurement is performed on the guide, is rotating the model, viewing it at various angles and thus checking if the measurement points are
still on the guide.

18.3. Notes

The notes panel (the "Notes" tab) is divided into three groups;

General

User notes

Consultant notes

The General section displays the content of files in the .txt format found in the folder from which the model has been loaded.



User notes and Consultation notes follow the same rules. They only differ destiny. User notes can be attached by a doctor or other person working with the model. Notes
consultative are intended for communication between the operator and the support person in the substantive scope - consultant.

Notes are information about the model itself or work being done on it. Notes are related to the model. Thanks to this important information about a particular order is always
attached to the file, which significantly organizes and facilitates work with many models. The header and content of the note are visible as a transparent rectangle in the work
area. This rectangle can be moved using the mouse.

 

When you click "add note" button a new window will pop up where you can enter the note content, select color representing the note in work area and change the adding date if
needed.



 

As you may have noticed right under notes toolbar there is a checkbox "Show notes only from active model". It may be handy when you want to filter notes attached to
particular model. Remember that notes may not be visible in the work area when the relevant checkbox in notes list is off.

In case of multimodel file when you work on other than primary model you will be asked first for selection a model that added note should be attached to. For instance, if you have
primary model opened and one extra added the dialog box will look like:

Each created note inside the "Notes" panel can be assigned to a specific place on the surface of the model. The common color acts as a bridge between the position on the list of
notes and the marked area on the surface of the model.

If there are not any notes in the list you can add one as was described above or you can select from existing ones. Once you have any note selected a program is switched into the
object drawing mode. If you move mouse cursor over the model surface and hold right mouse button the cursor will be painting over the surface with color of the note. If a note is
active (checkbox in the list is on) a corresponding transparent box is displaying in the work view. You can move it using left mouse button.

The are no limits concerning the area of marking. It can be both a single spot and a group of spots. The user can draw on the teeth and on the soft tissue.

In case of making a mistake while drawing, the marked area can be erased and the drawing can be begun again ( click right mouse button on the note from the list and select
"Clear note region" ).At any moment, if the user is in the panel of notes, a new note can be added or an existing one can be deleted.



Notes can be printed or saved to a file with the .txt extension in two ways - singly (currently selected note) and in bulk - all notes on one sheet / file.

Adding PDF Attachments to notes (Works only for User notes section)

As the text field of each note has limitations in terms of both volume and form, it is also possible to extend the documentation of the model to attachments in the form of PDF files.
This is also an easy way to easily add existing medical records to the case.

You can add any number of attachments to the model and they are automatically saved along with the model. This means that when you forward a model file to another person,
also linked PDF documents.

Please note that you can attach different sets of attachments for each available model (change active model in main menu: Manage models for operating with different set of
attachments).



Double-clicking the item in the list displays the contents of the file in the default installed PDF viewer.

18.4. Pictures

The photos can also be viewed in the "Pictures" tab. They are displayed as miniatures there. The mouse double click on the miniature opens the window with the picture in the
original size. To navigate between the available photos, use the arrow buttons located at the side edges of the photo.

After right-clicking on the selected photo, the user gains access to the following options:

edit the name and description assigned to this photo

export the picture(s) to the file

remove the picture

calibrate it

perform basic editing such as rotating, cropping or mirroring the picture, adjusting brightness and contrast

change position in the list

set the picture as a cephalogram (go to "Cephalometry" chapter to read more)

send to personal information data (see 3.4. Personal information chapter)

setting a picture as a floating window

The default setting is to display the photos that have been taken for the currently loaded model. You can also upload a model from any directory in the disc. Obviously, the images
related to this model will be displayed. However, in the directory from which the model was uploaded, there may also be some images. To make them visible, you should check the
Show pictures from model directory checkbox. Moreover you can display pictures stored in common DDP-Ortho images directory (My Documents/DDP-Ortho) by checking
Show external pictures option.

Switching to the "Pictures" tab, you can review the pictures that are related to the loaded model. They can be both pictures delivered with the model (images of examination
results, X-ray photos, oral cavity photos etc.) and screenshots taken in the DDP-Ortho program. They are displayed as miniatures one below another. Notice that some may have a
prefix that reads "Model A" or "Model B". It applies to multi-model case about which you can read in chapter 6.3. Multi-models management. As for extra info within picture's
name, an asterisks (*) means the picture is set as cephalogram and (CA) means the picture is calibrated.

You can change an order of displaying pictures using "Move up"/"Move down" option from the context menu.



Adding/removing the pictures, calibration.

An image of any location can be connected to the model. Upon clicking the Add picture button
(icon of the blue plus) the user can select the picture or series of pictures at once to be uploaded
from the chosen location. After clicking on the icon you can browse the picture files that will be
loaded. Once you select them a new window will pop up where you can assign series of
parameters to each loaded picture one by another.

The edit window contains text fields for inputting the image name and description. In case of loading number of images you can speed up the process using "Prefix" text field.
Simply enter some text in it and the prefix will be added at the beginning of picture name for every next picture. In practice the prefix is used for including patient's initials or
treatment stage or date. The other handy feature is filling the name field by clicking appropriate icon related to the preview of picture. If the "Append name" tag is active the file
name is added to picture name when clicking on one icon.

Before you go to the next picture (if selected more than one) you can do basic image processing like cropping, rotating or brightness/contrast/gamma adjusting. For some
purposes it is necessary to calibrate the picture (see details below). To access these function click on relevant button under the preview of currently edited picture.

You can skip editing current image by clicking "Cancel" button. Then the picture neither will be attached to the file nor general DDP-Ortho library. You can stop process of loading
pictures by clicking "Cancel all" button.

Calibration

You can access calibration window while loading pictures or from the context menu after the picture is loaded. The calibration is a process of rescaling the image to make the size
of the image elements fit the model size.

The calibration process is quite simple. Show the context menu for the picture to be calibrated and select Calibrate picture.

Mark with 2 point any element on the picture that its length is known, then enter the length to the textfield on the left and click Calibrate button. The picture is going to be
resized so that its scale will corresponding to the scale of the model.

 



Some pictures are equipped with special scale to make calibration easier:

Note: The pictures are physically removed from the disc. The Delete picture button removes any picture from the list of miniatures (not only those related to the model).

A picture of the current situation on the screen.

During work on a model, the user at any moment can take a photo of the screen - using the Tools/Take picture option in the main
menu. This function makes it much easier to discuss with another user some particular situation related to work with the DDP-
Ortho program.

While saving a screenshot, the user can name it and add a description to it. Some default size of a picture is offered, which
comprises the DDP-Ortho workpanel, based on the current resolution of the screen. The size can be changed, if for any reason it
is needed to take a picture of a higher accuracy, e.g. for large-format printing. It is recommended to change the resolution
maintaining proportions of the proposed default size (with marked "Keep proportions" checkbox). Otherwise the image will be
deformed.

The final resolution might be also given in inches. It is used when the picture is going to be printed and the size of print off is
known. Then DPI parameter determines quality of the prints.

Pictures are saved in JPG format. The quality of the saved picture depends on the value set by the "Quality" slide. However, the
better the quality, the bigger the file size is. It is recommended to set the slide at 70-80% of the maximum value. This is the
optimum, at which the size of the picture file is relatively small, and loss of quality is unnoticeable.



18.5. Smile simulation

If you have a photo of the patient's face, even a fragment of it with open mouth showing the dentition in frontal view, you can try to display a digital dentition model after the set-
up in place of the original dentition in the photo. Here are the steps to follow.

Prepare a photo that, if possible, meets the conditions listed above, for example:

Load the photo to DDP ("Pictures" tab) and go to the "Setup" tab. There, click on the drop-down list in the Simulation of smile group and select the entered photo:

A floating window with a photo will appear above the work area, in which you will select the teeth area, which will be removed so that it creates a lumen through which the digital
model will be visible. By using the mouse wheel, you can scale the photo so that the fragment with the mouth occupies comfortably a large part of the window. Then, using the
right mouse button, start placing points that will form the cutout outline:



You can change the position of each already placed point by simply dragging it. After setting all the points, confirm the contour with the OK button. The image inserted into the
work area will certainly not be in the correct position relative to the 3D model.

Using a group of buttons to position the photo, correct its position so that the 3D model takes the most natural position relative to the cut hole in the photo.

The final effect should look more or less like this:



18.6. Export of a geometric grid of a model

DDP-Ortho, because of its specific application, has its own confined format of description of the model structure and features. However, in case there is needed a presentation of a
DDP-Ortho model or a modification on the geometric structure level, it can be saved in the STL format. This format stores only the information of the grid of triangles, of which an
object consists. It is recognized by most of the 3D applications available in the market.

Only the visible components of the model are exported. In the below depicted situation only the geometry of maxilla and the teeth 1-1, 1-2, 1-3 and 1-4 will be exported.
Independent on the state of other display windows only the geometry visible in the active display window is exported. Therefore before selection of the File/Export option the user
should pay attention whether the appropriate display window is active.

18.7. Prints



DDP-Ortho is supplied with a few printing options. The “Print model 1:1” option enables the user to print the current view with a possibility of the image scaling.

Since the backround of the work area might be very often dark it will use quite lot of ink for printing. "Print view" (white background) is an economic version of print view. The
dark background is replaced with white colour what might save up to 80% of ink during printing.

The other printing options:

- Print model front view in 1:1
- Print model left view in 1:1
- Print model right view in 1:1
- Print model top view in 1:1
- Print model bottom view in 1:1
- Print occlusion

at print the model in the 1:1 scale it is impossible to reduce the printout size for them.

 

18.8. Force calculations

This part of the program is only active for models with the appropriate mark included in the model file. Here you can make simple calculations of resultant forces and



compensating torques.

For more convenient operation, enable "Custom gizmos design enabled" in the options.

We start by selecting one of the three available types of calculations.

Sum
Let's start by calculating the resultant force, which in practice comes down to summing the force vectors. Add the first force vector. You can use the Add new vector button

or double-click with the right button on the model, indicating the point of application of the added force. Try to add a second vector by double-clicking on the tooth surface as in
the figure below:



After adding at least two forces, the resultant force vector and the torque of this force relative to the resistance point are calculated. The Input section of the selected calculation
contains vectors of forces added by the user. Clicking on one of these items allows you to edit the added force. The floating window allows for precise transformations (rotation and
translation) in the local coordinate system, although you can also change the point of force application or its orientation using the manipulator displayed around the selected force.
Similarly, you can edit the location of the center of resistance point relative to which the resulting torque is calculated. Each change causes the resultant force and the torque of
this force to be recalculated on the fly.

In the figure above, the resultant force is marked in green. You cannot change it directly, apart from moving it along its axis, which does not affect the component values of the
given input vectors and the values of the resultant moment and the orientation of the plane in which it operates.

You can add any number of component forces. By right-clicking on its counterpart in the Input list, you will find basic options for editing it, such as - changing the color, name,
value of this force or deleting it. There is also an option (Show vector coordinates), thanks to which you can check the exact coordinates of its application point and the vector
vertex.

Subtraction
Add a new calculation, this time selecting the Subtraction option. For better clarity, turn off the checkbox for displaying the sum calculation in the list:



If there is more than one calculation on the list, pay attention to which one is currently selected (by clicking on it on the list). When you add a vector using the Add new vector
button, it will be the default position in the calculation list to choose from. Of course you can change it.

The first vector added is "Minuend", each subsequent vector added ("Subtrahend") will decrease its value. The resultant length may seem unintuitive at first glance:

because in the case of the "Subtraction" calculation, each vector added after the first one acts as if it were added with the opposite direction. The illustration below explains how
the "Subtraction" algorithm can be easily transformed into an equivalent "Sum" situation:

Force replacement
This calculation is used to calculate the equivalent of the resultant force added to the working area, which is based on the points on the model indicated by the user. The resultant
force can be deposited at any point in space, even not necessarily touching the surface of the model. This calculation is just for calculating a pair of forces that, when applied at
the indicated points on the model, will produce exactly the same effect as the resultant force. In order to understand the usefulness of this calculation, let's trace step by step the
methodology of how this calculation works.

Let's assume that a force acting on the model has been added, but for some reason it cannot be applied in such a way that it acts along its line.



However, we know that we can apply equivalent forces at the points indicated by the red arrows in the figure:

So we point them out on the model with a double-click with the right mouse button. If necessary, we refine their position. The result right after pointing the forces will look like
this:



Let's analyze how the directions of the Vector 1 and Vector2 vectors were calculated. Let's go back to the situation when only the resultant force was present and the points of
application of equivalent forces were indicated. Due to the inability to maintain the resulting force in the given position, the program moves it to the first indicated point. However,
as a result of such a shift, a torque is created relative to the point of application of the initially added force:

The torque M = FW*r created by the translation is compensated by the opposite moment created by the forces Fk1 and Fk2 applied at the indicated points:



In this way, the torque M resulting from the shift of the resulting force was equalized by the sum of neutralizing torques in accordance with the principles of static equilibrium: ∑Mi
= 0

FW*r + Fk1*r1 + Fk2*r2 = 0

The last step of the procedure is to combine the forces FW and Fk2:

Here is the final effect of the operation, which consists in converting the resulting force into 2 substitute forces producing the same effect, but applied at points selected by the
user:



Let's take a look at a slightly different case to show tools that can be helpful in certain situations. In the figure below, the resultant force has been applied to the front tooth in the
horizontal direction. Having indicated the 2 points of application of the equivalent forces, you can trim the model with the plane determined by the directions of the forces present
in the case:



You can change the orientation of the alternate forces with the slider without damaging the system:

You can turn off plane cutting with the Clear Cut button.

 


